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Preface  
In this workshop, you will construct a roadway interchange horizontal and vertical layout utilizing the  
V8i SELECTseries 3 Horizontal Civil Geometry tools. We have structured the contents of the exercises 
herein to allow your interaction with a broad range of available tools. However, we will not use every 
tool. Also, it is impossible to engineer a complete interchange in the time frame of this workshop, but 
we will use the tools in their real-life context, so you can see how to utilize them in your own 
engineering projects.  

This workshop is equally applicable for MX, InRoads or GEOPAK families of products. Each product 
contains the identical toolset and identical workflow. The only differences between the three 
products for the tools are slight differences in the use of feature definitions and some differences in 
the back-end interaction with other native toolsets such as drainage. 

There are more exercises in this manual than we will have time to cover today. We will all complete 
the basic set of exercises, and for those veteran users in the group who complete them and still have 
time left in the exercise session, you are welcome to work on the optional exercises.  

In order for all participants to design the same layout and to stay on course and on time, we request 
that all participants utilize the files as listed in the workshop materials. At the beginning of each 
chapter, we will start with a fresh set of data. This ensures that everyone is using the same data, plus 
we have added data to avoid redundant work. For example, we draw some of the edges of pavement 
in the lab so you can understand the workflow, but have drawn the remainder in for expediency of 
time. 

The workshop guide is yours to take with you. If you don’t finish all the exercises, or just want to 
work with the dataset upon return to your office, the datasets (both initial and completed files) are 
provided on the Conference DVD. This workshop also has videos of all exercises on the DVD.  

Note Prerequisite Knowledge Level: Participant should have a basic understanding of road design 
principles and be fluent in use of MicroStation and the native application (MX, InRoads or 
GEOPAK) or one of the Power products.  
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SESSION DESCRIPTION 

This hands-on workshop provides introductory training for the creation, manipulation, and 
annotation of new horizontal geometry in Bentley civil SELECTseries 3 products. Can you live without 
dialogs and menus? Learn to use these new intuitive, context-sensitive horizontal geometry tools. 
This workshop is targeted for all Bentley civil users. 

LEARNING OBJECTIVES 

After this course you will be able to: 

 Import horizontal geometry from native products. 
 Create horizontal geometry elements from task navigation. 
 Edit / manipulate elements using edit handlers / manipulators. 

Note At the end of this training session, an assessment will be given. We will review all 
assessment questions and answers to see what you have learned. 
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Chapter 1: Introduction to Horizontal 
Geometry Tools 

OVERVIEW 

Civil Geometry is a dynamic, interactive, rules-based approach to geometry that provides an 
unprecedented level of associativity by preserving design intent, snaps and Civil AccuDraw input. The 
results of the tools are intelligent graphic elements which can be dynamically edited and associations 
between elements which are automatically updated. 

The results of the tools are graphical geometry elements stored as MicroStation elements. There is 
no external geometry file. The geometry elements are MicroStation elements with additional 
intelligence applied to store the rules and associations.  

The Civil Geometry tools are installed as a part of GEOPAK, InRoads and MXROAD products. In order 
to be consumed by processes within GEOPAK, InRoads and MXROAD, the civil geometry must be 
written to the native application coordinate geometry file (ALG, GPK or FIL). This can be configured to 
be handled automatically based on properties of feature definitions, or else it can be done manually. 

PROJECT DESCRIPTION 

In this workshop, we will construct a mainline alignment, a cross-road alignment, and an interchange 
including ramps, loops and access roads. Note the view is rotated so the mainline is displayed in a 
west-east orientation.  

 

Alignments created with horizontal geometry tools 
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The table below details the dimensions that will be used throughout the project. 

DESCRIPTION VALUE 

Units Metric 

Lane Width 3.6m 

Ramp Width 5.0m 

Median Width 3.5m centerline, 3.0 loop/ramp 

Entrance Taper 1:50 

Exit Taper 1:15 

Stationing Format 1+234 

NAVIGATING TASKS 

Within the Tasks dialog, the General Geometry and Horizontal Geometry tasks are located in the Civil 
Tools Workflow.  

 

Click Activate Workflow to view the main tasks.  To open the toolset, click Expand Group. Click the 
same icon to Collapse the Group. 
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There are several ways the Groups can be displayed.  For this workshop, we’ll use the Panel Layout 
Mode, which is the default.  

 

If you prefer listings rather than icons, you may prefer the List Layout Mode. 
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Your preference may be to not use the Task dialog. Other options include: 

 Select any tool from Tools > Civil Geometry from the Power product main menu bar. 
 Select <F2> from your keyboard, which opens the main workflows pop-up menu.  This may 

vary depending on what products are installed and any task customization.   Select Civil 
Geometry. Select <F2> from your keyboard and General Geometry from the pop-up menu.  
Then you can use Q, W, E, R, T, or A (corresponding to the letters to the left of the group). 
For example, selection of W opens the Geometry Import/Export pop-up menu. 

 

To use the classic toolbox for any sub-group, right-click   on the line and select Open ‘…’ as Toolbox.  

 

You can also customize which tools are displayed. Other customizing options can be found by right-
clicking on the navigation groups. Customization of task navigation is outside the scope of this 
workshop, but you may want to experiment in your spare time or after the workshop is concluded.  

Hint If the Task dialog disappears or you accidentally close it, select Tools > Tasks from the 
Power product main menu bar to bring it back. 

GETTING STARTED 

In this section, we will review some of the tools and settings that will be used throughout the 
workshop. For easy accessibility, we will dock the tools within the MicroStation view.  
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 Exercise: Open Design File and Tools 

Lesson Objective: 

 We’ll set up for Design Standards, Features, and Messages for subsequent exercises. 

Tools Used: 

GENERAL GEOMETRY GROUP ICON TOOL 

  

Design Standards Toolbar 

  

Features Toggle Bar 

  

Civil Message Center 

MicroStation > File > Project Explorer 

 

Project Explorer 

Procedure: 

1. Double-click the Power InRoads or GEOPAK icon on your desktop. 

2. In the lower right corner of the File Open dialog, set the User to Examples, Project to 
Bentley-Civil-Metric, and Interface to Bentley – Civil. 

3. Navigate to the class folder as directed by the instructor, select Start_ch1.dgn and click 
Open. 
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4. Select the Design Standards Toolbar tool from the General Geometry group.  Dock the 
Design Standards Toolbar on the top. 

  

5. Verify that the Features Toggle Bar tool is already docked on top.  If not, select it from the 
General Geometry group, dock and pin.  Don’t select any feature for now. 

 

6. Verify that the Civil Message Center tool is already docked on the bottom. If not, select it 
from the General Geometry group, dock and pin.  

This is for feedback on our design standards and geometry tools.  

 

7. Verify that the Project Explorer is docked on the left side. If not, from the Power product 
main menu bar, select File > Project Explorer, dock and pin.  

Hint The Project Explorer can also be found in the Primary Tools toolbar, but is hidden 
by default.  Right-click on the toolbar and select Project Explorer to enable access 
from the toolbar. 

This is for reviewing design standards and feature definitions.  

 

Note The tabs shown on your Project Explorer may be different from those shown in 
the image above. You can control what tabs are displayed by going to the 
Settings > Project Explorer dialog and disabling or enabling the desired tabs. 
The only tab we will be using in this workshop is the Civil Standards tab. 
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FEATURES AND FEATURE DEFINITIONS 

In our initial set-up, we opened the Features Toggle Bar.  

 

Feature definitions are used to define options when creating features. These are the items which are 
created in advance, usually used across multiple projects, and define symbology, annotation and 
quantities. The feature definition is assigned (usually) in the plan model, and optionally in profile and 
3D feature definitions. 

A Feature is anything that can be seen or located and is a physical part of your design, representing a 
real world entity.  Examples include curb and gutter, pavement, power lines, trees, etc.   

A feature’s definition is one of its properties. At any given time in the design process, the feature will 
have horizontal geometry, vertical geometry, 3D geometry or a combination to define its location.  
Generally, the feature’s definition is assigned at time of creation, but can be assigned after-the-fact.   

Most Civil tools have entry fields for Feature Definition in their dialog. One example is illustrated 
below. 

 

The rules applied to Feature Definitions are: 

 If no Feature Definition is selected, the active MicroStation symbology is used and 
no feature is defined, but you can define a Name Prefix. 

 If a Feature Definition is assigned, a Name Prefix is applied, and the symbology, 
attributes, and annotation defined in the feature definition are applied to the 
element. 

Note It is often useful to set the tool to “Active Feature” and then control the active feature to 
be used in the Features Toggle Bar. Alternatively, you can choose a specific feature 
directly in the tool dialog and ignore the toggle bar. 

IMPORTING DATA 

To begin any project, you will need some type of existing data. It may be CAD files from prior 
projects, survey information, or even historical paper plans. You can mix and match the type of data 
you have for your project.  If you have no data, you can even start with a blank file. 

In our project, we will use some historical data to create one of our crossing road centerlines. For 
another alignment, we will import our mainline alignment from another project. We will then modify 
the alignment to adhere to our design standards.  
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 Exercise: Import the Existing Centerline  

Objective: 

 Import the mainline alignment and display in our file.  

Geometry Tools Used:  

GENERAL GEOMETRY GROUP ICON TOOL 

  
Import Geometry 

Procedure: 

1. Continue in Start_ch1.dgn. 

2. Select the Import Geometry tool. 

3. Power InRoads: Select mainline.alg (in your project folder) and click Open.  

4. Power GEOPAK: Select job99.gpk (in your project folder) and click Open. 

 

5. Navigate the tree and toggle on MAINLINE. Note the upper part of the hierarchy is toggled 
on also. We will not import the profile in this workshop.  Note your dialog may vary slightly 
depending on the native product being used to import.  

6. Verify that Create Civil Rules at the bottom of the dialog is toggled ON.  

7. Click Import.  

8. Note our view is rotated so it will display in a west-to-east direction. Since we did not select 
a feature definition, a default feature definition or the active MicroStation symbology was 
used.  

 

Imported existing mainline alignment (shown without background file) 
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USING HISTORICAL DATA 

We will use some historical survey points to create the centerline for the intersecting highway. This 
stretch of roadway is a tangent section, so it’s easy to create. We could just use the Line Between 
Points tool, but we want to maintain the location of the historical points. So, we’ll place the points 
first, and then draw a civil element (line) between them.  

 Exercise: Create Cross-Road from Historical Data 

Objective:  

 Create two historical points which will be displayed as triangles. Then we’ll connect them with a 
civil geometry line. Note this alignment will be in a north-south direction and drawn in red.  

 

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Point 

 
 

Line Between Points 

Procedure: 

1. Continue in Start_ch1.dgn. 

2. Select the Saved View “Cross Highway.” 

3. Open Views 2 and 3 (which has the areas of the points in large scale for easy viewing). 

4. Select Utilities > Key-in from the Power product main menu bar. We’ll use this for the 
coordinate data input.  

 

5. Select the Point tool. 

6. Set the Feature Definition to Geom_Key (using the pick list).  Note your list may vary from 
the illustration below. 
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7. Now we’ll follow the heads-up prompts attached to the cursor to draw our points: 

HEADS-UP 

PROMPT 
USER ACTION 

Enter Data Point In the Key-in dialog opened in step 4, carefully type in: (do not space before or after the 
equal sign and include the comma) 

xy=767641.50,179118.90 <enter> 

Enter Data Point In the Key-in dialog opened in step 4, carefully type in: (do not space before or after the 
equal sign and include the comma) 

xy=767283.123,179478.032<enter> 

 

Two orange X’s are drawn into the file.  

 

Note If the orange X’s do not display, then the preference setting pointing to the 
correct native feature file (.XIN, .DDB, .PSS) is not set correctly. 

8. Select the Line Between Points tool.  

9. In the dialog, select the Feature Definition Geometry > Geom_Secondary from the pick list.  

Notice the list is different than when we defined the Points. The pick list differentiates 
between linear and point feature definitions.  

10. Follow the heads-up prompt attached to the cursor to draw our alignment. 

HEADS-UP PROMPT USER ACTION 

Enter Start Point Select the southern point you just placed. You can zoom in and out to reach the point 
or use view 3. 

Enter End Point Select the northern point you just placed (using view 2 for a close-up). 

11. We now have the existing cross road alignment drawn in red. If yours is another color, then 
you didn’t set the Feature Definition correctly. Simply undo the element and place again.  

 

Two existing alignments are now displayed 
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STATIONING AND STATION EQUATIONS 

When creating an alignment, the stationing is set to zero by default. However, you may want to 
station your alignments or add station equations. In order to add stationing, we need to specify the 
station value and define the point where the station should be applied. For this workshop, we will 
station our cross road alignment. Please note that station equations are outside the scope of the 
workshop.  

 Optional Exercise: Adding Stationing to Cross Road Alignment 

Objective:  

  Add initial stationing of 10+000 to our cross road alignment.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Start Station 

Procedure: 

1. Continue in Start_ch1.dgn. 

2. Select the Start Station tool. 

3. As we are not drawing any elements, this dialog does not have a feature definition.  

4. Now we’ll follow the heads-up prompt attached to the cursor to station our alignment. 

HEADS-UP PROMPT USER ACTION 

Locate Element Select the cross road alignment near the southern end. 

Start Station Position / Start Distance  Type 0 <enter>. Then data point on screen to move to the next 
prompt. 

Enter Starting Station / Start Station Type 10+000 <enter>. Then data point in the workspace to complete.  

 

5. Just above the Civil Geometry group task, click on Element Selection. Then select the 
alignment. The edit manipulators and station are now displayed. 
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The Element Selection icon is used to select civil geometry elements and display edit manipulators. 

 

Hint The size and colors of the manipulators can be user-defined in the 
Workspace > Preferences > View Options – Civil. 

 

CHAPTER SUMMARY 

In this chapter, we have learned how to import horizontal geometry from an existing ALG file 
(created in Power InRoads) or GPK file (created in Power GEOPAK), and also how to manually enter 
points from historical data. We created a single line alignment and added stationing. 
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Chapter 2: Alignments and Standards 

DESIGN STANDARDS 

Design standards should be used throughout the design of your project.  It ensures that you are 
meeting minimal standards, generally based on design speed. They can also be based on type of 
roadway, and other geometric or design characteristics.   

Design standards are developed for both horizontal and vertical geometry (vertical new in Bentley 
Civil V8i SELECTseries 3!) and are stored in DGNLibs.  Several default libraries are provided in the 
installation packages.  They are utilized by including the file / path in your MS_ DGNLIBLIST 
configuration variable.  An organization can modify the default libraries or create them from scratch, 
depending on your standards.   Multiple standards can be utilized, i.e., consulting firm doing work for 
multiple governmental agencies who all have their own standards.  

As you select a standard, it is copied from the DGNLib into your design file.  Therefore, your 
organization can maintain the integrity of the standards by having them “read-only” in a central 
location, but a designer has the flexibility to override for a project-specific circumstance.   The Project 
Explorer has one set of standards derived from DGNLibs, and another set shown for the design file.  

 

  



Design Standards 

 

20  Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical 

Geometry 

  Copyright © 2013 Bentley Systems, Inc. 

In the Design Standards Toolbar, the Active Design vs. Design Library standards is clearly marked.  
Either can be selected for use. 

   

USING DESIGN STANDARDS 

Design standards can be used to maintain required curvature and other horizontal and vertical 
alignment checks when performing geometric layouts. They work at two levels: 

 Provide values for the element creation tools (for example, minimum radius and transition 
lengths in horizontal geometry, maximum slopes and K values for vertical geometry) 

 Check the suitability of complex elements (for example, check for kinks in both horizontal 
and vertical geometry) 

       

Examples of horizontal (left) and vertical (right) design standards 

DESIGN STANDARDS TOOLBAR 

The Design Standards Tool bar is accessible in either the General Geometry or Horizontal Geometry 
tool panels: 
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There is one icon for the Toolbar and a separate icon for the Set Design Standard tool, which is 
located on the Design Standards Toolbar. 

 

This toolbar allows you to set an active design standard subsequently used by most geometry tools. 
The leftmost icon is Set Design Standard, which can be used on previously created geometry 
elements. 

Procedure: 

1. Select the desired standard.  When a horizontal standard is selected, the “linked” vertical 
standard is displayed by default.  However, you can override by selecting a different 
vertical standard from the pick list.  

2. Toggle on the Toggle Active Design Standard (directly left of the horizontal design speed).  
When on (which appears orange), all civil geometry tools will use the values contained in 
the standard as defaults. When off, the selected standard is ignored. 

3. Create geometry elements.  

4. Selecting the element and opening Element Information displays the standard and 
associated values. 

       

Example of Horizontal and Vertical Design Standards Within Element Information 

 

Hint To remove a standard from a geometry element, right-click on the 
standard in Element Info and select Remove Standard. 
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DESIGN STANDARDS FEEDBACK 

When a design standard is violated, feedback is provided in two ways: 

 An icon in the graphics on the element that has the problem. Hover over the icon to reveal a 
tool tip report of the error. 

 In the Civil Message Center. 

 
Sample messages in the Civil Message Center 

The tabs work like filters, so you can turn off / on MicroStation / Warnings / Errors as desired.  To 
quickly find the location of a problem, right click on the Warning or Error and select Zoom To.   

 

With the exception of the MicroStation messages, onscreen glyphs are displayed in the workspace to 
pinpoint the location.   

 

Error (left) and Warning (right) Glyphs 

Hovering over the glyphs displays a pop-up with the warning / error message. 

 

Example Pop-up Warning Message 



Design Standards 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 23 

Copyright © 2013 Bentley Systems, Inc. 

CREATE THE NEW CENTERLINE BASED ON STANDARDS 

Objective: 

In this series of exercises, we will utilize the design standards and feature definitions to modify the 
centerline for our mainline roadway. We’ll use the eastern and western tangents, then rebuild the 
center section with arcs and tangents. The goal is to shift the roadway to lessen the skew between 
mainline and the intersecting highway. This will help in the design of a full cloverleaf interchange. 

 

We’ll utilize the green sections of our existing alignment, and rebuild the center section (in black).  

 Exercise:  Draw a Northbound Arc from the West End Mainline 

Objective: 

 Using the tangent from our existing alignment, we’ll draw an arc heading northward.  Its length 
doesn’t matter, as we’ll trim it later.  We’ll use our standards to define the radius of the arc.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Simple Arc From Element 

 

Procedure: 

Hint Remember if you don’t like what is drawn, use the “Undo” tool <ctrl> - Z 
on your keyboard or Edit > Undo on the Power main menu bar!  

1. Open Start_ch2.dgn.  

2. Select the 70 KPH design standard (UK DMRB TD 9-93) from the Design Standards Toolbar. 
(This was docked in an earlier exercise.) 

 

3. Toggle on the Toggle Active Design Standard, so it appears orange. 

Any subsequently created geometry elements will use the selected standard.  
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4. Select the Simple Arc from Element tool and follow the heads-up prompts.  

HEADS-UP PROMPT USER ACTION 

Locate Element Select the green tangent at the west of the project.  

Enter Start Point Snap to the right end of the tangent.  

Thru Point or Radius Data point to accept the Radius of 510 (from our standards).  Note the lock to the 
right of the value in the heads-up prompt. 

Define Arc Length Move the cursor towards the top of the screen (so arc is displayed going northward).  
As you move the cursor, the Arc Length is changing. Data point when the length is 
approximately 250m.  

 

Trim / Extend Select Back (using the down arrow on your keyboard to toggle through the options) 
and data point to complete.  

 Exercise: Adding an Arc on the East End of the Project 

Objective:  

On the east end, we are going to add an arc starting from the existing tangent and go southward.  
Again, we’ll use our standards for the Radius value and an approximate length.  We could use the 
same tool as the last exercise, but our goal is to practice as many tools are possible. So, we’ll use the 
Arc From Element in this exercise, which has a few more options than the Simple Arc From Element 
tool. 

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Arc From Element 

 

  



Design Standards 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 25 

Copyright © 2013 Bentley Systems, Inc. 

Procedure: 

1. Continue in Start_ch2.dgn.  

2. Continue using 70kph and be sure the toggle is on so it appears orange. 

3. Select the Arc from Element tool and follow the heads-up prompts. Note this tool is 
accessed by clicking on the small black triangle in the lower right corner of the Arc tools 
and selecting from the list.   

Warning It is not the same tool as used in the previous exercise,which was 
the SIMPLE Arc from Element tool.   

HEADS-UP PROMPT USER ACTION 

Locate Element Select the green tangent at the east end of the project (right side of screen).  

Enter Offset Type 0 <enter>. Data point on the screen to move to the next prompt. 

Enter Start Point Snap to the left end of the tangent.   

Thru Point or Radius We’ll use the 510 value from our standards, but DO NOT data point yet! Note the 
<=> at the right of the Radius value. This indicates additional options. Select the 
right arrow on your keyboard. 

Back Transition Length We’ll use the 0 value for no transition.  If it’s not 0, change the value. You’re your 
cursor so the angle is pointing downwards on the screen.  Data point on the 
screen to move to the next prompt.  

Define Arc Length Move the cursor towards the bottom of the screen (so the arc is curving 
downwards) to see the arc dynamically displayed. As you move the cursor, the 
Arc Length is changing. Data point when the length is approximately 300m. 

 

Trim / Extend Select Back (using the down arrow on your keyboard to toggle through the 
options) and data point to complete the arc and back transition.  

 

Completed arcs  
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 Exercise: Connect the Arcs and Complete the Alignment 

Objective: 

 Now we need to draw the tangent to connect the curves.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Line Between Arcs 

 

Procedure: 

1. Continue in start_ch2.dgn. 

2. Select the Line Between Arcs tool. 

3. Follow the heads-up prompts to draw the line. Note we will be creating our alignment from 
west to east, so draw the line in that direction. 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the western arc.  

Start Offset Set to 0 and data point to accept.  

Locate Second Element Select the eastern arc. 

Second Offset Set to 0 and data point to accept. 

Back Transition Length Set to 0 and data point to accept 

Ahead Transition Length Set to 0 and data point to accept 

Solution Actually, there are four solutions. Click <Alt> on your keyboard to see 
each solution. When the desired solution is displayed, data point to 
accept. 

Trim / Extend Use the down arrow on the keyboard for the Both option, then data point 
to complete. 

 

  

Tangent is drawn between two arcs, completing our last working element. 
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COMPLEX ALIGNMENTS WITH FEATURE DEFINITIONS AND NAMING CONVENTIONS 

Now we are going to connect all the working elements together in one alignment. At the same time, 
we’ll use a feature definition, so we get the correct symbology, correct naming, and persist back to 
the ALG file. 

Along with the feature definition, we have a name prefix which functions like an auto numbering 
process. For example, the first element would be named CL; the next would be CL1, CL2, and so on. 
But it can also be used for absolute naming which is especially useful for alignments. So, for example, 
I could have entered a name prefix here of “BOB RD” and since there is no other element with that 
name, the alignment would be named “BOB RD”. In other words, no suffix.  

 Exercise: Create a Complex Alignment From Elements 

Objective:  

 Create one alignment from our various working elements.   

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Complex By Elements 

 

Procedure: 

1. Continue in start_ch2.dgn.    

2. Select the Complex By Elements tool to create the alignment (from left to right on the 
screen).  

3. In the dialog, set the Method to Automatic and the Maximum Gap to 0.03.  

4. Set the Feature Definition to Geom_Centerline and the Name to MAIN. 

 

5. When prompted to Locate the First Element, select the western-most tangent, being 
mindful of the arrows. If the arrow is going the wrong direction, move the cursor until you 
get the correct direction.  Data point to accept the first element, and all the rest will 
automatically highlight.  The alignment is chained together and the symbology is changed 
to match the feature definition.  
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Mainline and cross highway alignments have been created 

6. Click on the Civil Message Center which was docked in an earlier exercise.  

 

7. To see the location of the warning, right-click over the warning symbol and select Zoom To. 
Once we have remedied any warning or error messages, the Message Center is updated.   

Note On your projects, you can review and determine which warnings / errors need 
to be addressed by redesigning / adjusting. The Messages are dynamic, so that 
when an alignment is changed to comply with standards, the warnings are 
deleted.  

 Exercise: Adding Stationing to Mainline Alignment 

Objective:  

Add initial stationing of 10+000 to our mainline alignment.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Start Station 

Procedure: 

1. Continue in start_ch2.dgn.    

2. Select the Start Station tool. 

3. As we are not drawing any elements, this dialog does not have a feature definition.  
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4. Now we’ll follow the heads-up prompt attached to the cursor to draw our alignment. 

HEADS-UP PROMPT USER ACTION 

Locate Element Select the mainline alignment. 

Start Station Position / Start Distance  Type 0 <enter>. Then data point on screen to move to the next prompt. 

Enter Starting Station / Start Station Type 10+000 <enter>. Then data point on the screen to complete.  

5. Just above the Civil Geometry group task, click on Element Selection. Then select the 
alignment. The edit manipulators and station are now displayed. 

 Exercise: Reporting on the Mainline Alignment 

Objective:  

 Create a geometry report based on the previously created alignment (MAIN). 

Geometry Tools Used:  

ANALYSIS AND REPORTING PANEL ICON TOOL 

  

Horizontal Geometry Report 

Procedure: 

1. Continue in start_ch2.dgn.    

2. Select the Horizontal Geometry Report tool.  

3. Now we’ll follow the heads-up prompt attached to the cursor to draw our alignment. 

 

HEADS-UP PROMPT USER ACTION 

Locate Element Select the MAIN alignment. Reset to Complete. 

Start Station Lock to starting station. You can do this either via the dialog toggle or by using the <Alt> 
key on the keyboard. Data point to accept. 

End Station Lock to ending station. You can do this either via the dialog toggle or by using the <Alt> 
key on the keyboard. Data point to accept. 

Interval Key in 10. Data point to accept. 

Select Profiles None. Data point to accept. 

4. Review the generated report as well as others in the Civil Report Browser. 

SETTING FEATURES AFTER-THE-FACT 

Did your alignment not change to red after creating complex from elements? Perhaps you forget to 
set (or incorrectly set) the Feature Definition?  

No problem, there’s a tool to set a Feature Definition after elements are drawn.  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Set Feature Definition 
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Procedure: 

1. Select the Set Feature Definition tool. 

  

2. Select the Feature Definition from the pick list (linear options only).  Assign a name, if 
desired.  Otherwise, a default name will be applied. 

3. Select the elements to apply the Feature Definition. Multiple elements may be selected 
without reselecting the tool. 

SETTING DESIGN STANDARDS FEATURES AFTER-THE-FACT 

Did you forget to set (or incorrectly set) the Design Standard? Or would you like to check an existing 
alignment?  

No problem, there’s a tool to set a Design Standard after elements are drawn.  

GENERAL GEOMETRY GROUP ICON TOOL 

  

Set Element Design Standard 

Procedure: 

1. In the Design Standards Toolbar, select the desired Design Standard from the pick list. 

 

2. Select the Set Element Design Standard tool. 

3. Select the elements to apply the Design Standard. Multiple elements may be selected 
without reselecting the tool. 

 

CREATING NON-ALIGNMENT ELEMENTS 

The horizontal geometry tools are used for more than just centerline alignments. In this session, we 
will utilize more of the horizontal tools in conjunction with feature definitions to construct the edges 
of pavement and shoulders for the mainline roadway. We need these in place before we develop the 
loop and ramp alignments.  

 Exercise: Construct the Edges of Pavement and Shoulders 

Objective:  
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Construct edges of pavement and shoulders for both sides of the mainline alignment. We’ll also use 
the Feature Toggle Toolbar to set the feature definition. 



Creating Non-Alignment Elements 

 

32  Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical 

Geometry 

  Copyright © 2013 Bentley Systems, Inc. 

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Single Offset Entire Element 

Procedure: 

1. Continue in start_ch2.dgn. 

2. Disable the design standard by clicking the toggle so it no longer appears orange. 

3. Set the Feature Definition in the Toggle Toolbar to Linear > Roadway > Road_Shoulder and 
toggle ON the Override Feature Definition icon directly to the left of the feature definition 
(shows orange when toggled on). 

   

Hint The Features Toolbar should be docked from an earlier exercise. If it’s not 
docked, select Tools > Civil Geometry > Geometry Toggles > Features 
Definition Tool Bar from the Power InRoads main menu bar and dock at this 
time. 

4. Select the Single Offset Entire Element tool.  

On the tool dialog, note the Feature Definition is already set to Use Active Feature. 

5. Now we’ll follow the heads-up prompt attached to the cursor to draw our elements: 

HEADS-UP PROMPT USER ACTION 

Locate Element Select the mainline centerline. 

Offset Key in 3.5 <enter>. Note the lock symbol to the right of the offset value.  
Move cursor to the right side of the centerline and data point to accept the construction and 
create the offset element. 

Mirror Use the down arrows on your keyboard to toggle between No and Yes. Change the option to 
Yes and data point to accept. 

Now we’ll repeat the steps to draw the edges of pavement.  

6. Set the Feature Toggle Toolbar to Linear > Roadway > Road_EdgeOfPavement and be sure 
the Override Feature Definition icon is still toggled on (orange). 

7. Select the Single Offset Entire Element tool, if not already active. 

8. Now we’ll follow the heads-up prompt attached to the cursor to draw our elements: 

HEADS-UP PROMPT USER ACTION 

Locate Element Select the mainline centerline. 

Offset Key in 17.4 <enter>. Note the lock symbol to the right of the offset value.  
Move cursor to the north side of the centerline and data point to accept the construction and 
create the offset element. 

Mirror Use the down arrows on your keyboard to toggle between No and Yes. Change the option to 
Yes and data point to accept. 



Creating Non-Alignment Elements 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 33 

Copyright © 2013 Bentley Systems, Inc. 

 Optional Exercise: Drawing Partial Element for Southern Loops 

Objective: 

Now we’ll draw another parallel element to use for our southern loops, this time just in the area of 
the interchange.  

Geometry Tools Used:  

 

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Single Offset Partial Element  

 

Procedure: 

1. Continue in Start_ch2.dgn.  

2. Set the Feature Toggle Toolbar to Linear > Geometry > Geom_Ramp be sure the Override 
Feature Definition icon is still toggled on (orange). 

3. Select the Single Offset Partial Element tool.  

4. Now we’ll follow the heads-up prompt attached to the cursor to draw our elements: 

HEADS-UP PROMPT USER ACTION 

Locate Element Select the mainline centerline. 

Offset Key in 22.3 <enter>. Note the lock symbol to the right of the offset value. Note the <> 
to the right of the edit field. This indicates additional prompts. Press the<right arrow> 
on your keyboard.  

Start Distance Key in 10+200 <enter>. Move the cursor to the south side of centerline and data 
point.  

End Distance Key in 10+650 <enter>. Data point to complete the construction. 

Mirror No. 

 

   

Non-alignment elements drawn with offset tools 
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EDITS AND MANIPULATION OF ELEMENTS 

One advantage of placing civil elements is the ability to dynamically edit them. By selecting the 
element, edit manipulators are displayed. Edit fields are supported for many properties, along with 
graphic handlers for dynamic movement. The edit fields and handlers are based on the type of 
element selected and the tool used to place them.  

 Exercise: Edit the Pavement Widths 

Objective: 

In this lesson we will correct an error in the pavement edge calculations. Our section is 3 lanes in 
each direction (3.6m per lane) plus a (3.5m) median each side of centerline. So the outside edge 
should have been set at 14.3m not 17.4m. 

Geometry Tools Used:     None. 

Procedure: 

1. Continue in Start_ch2.dgn.  

2. Select one of the outside edges of pavement. Note the width drag handle at the midpoint. 

 

3. We could drag this to set the width dynamically, but a more precise entry is needed. 

4. Zoom in to the roadway (at mid-point or either end) until you also see a text manipulator 
for the width. Click on the text to allow changing of the value. Change the offset to 14.3m. 

 

5. Repeat on left side with a value of -14.3m.  Don’t forget the minus sign, otherwise it will 
shift to the right side of the roadway, on top of the other edge of pavement. 

Hint If you get it wrong just undo with <CTRL> Z. 
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CHAPTER SUMMARY 

In this chapter, we have utilized Design Standards to develop new alignments and learned how 
Feature Definitions affect the horizontal geometry elements. We have used the tools to develop non-
alignment elements, and then manipulated them. 
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Chapter 3: Developing Loops 

OVERVIEW 

In this chapter, we will construct the inside loops. We can use the Arc Between Elements tool to 
construct the entire loop or ramp in one operation. In addition to spiral transitions, the tool can 
create arc transitions as well, which allows you to create 2-center and 3-center curves. By using the 
Design Standards tool, we can draw the elements to the desired design speed. We’ll use our mainline 
and cross road alignments, and use offsets to define the starting and ending points. In that way, if we 
adjust the alignments, we can also update the loops or ramps. 

ELEMENT SELECTION FOR COMPLEX TOOLS 

Now that we are starting to build more complex elements, we need to understand the relationship 
between the various input fields. In this chapter, we need two alignments to fit the loop or ramp. 
While we can select the elements in any order, each selection has associated transition and taper 
options. For example, if we select our mainline alignment as our first element, the Back Taper and 
Transition are based on that alignment. The second selected element relates to the Ahead Transition 
and Taper options.  

The loops have some severe constraints that will reduce the design speed of the ramps. We will 
develop the inside edge as the alignment, then offset for the outside edge of the loop.  

 

 Exercise: Construct The Northeast Loop Alignment 

Objective: Construct the inside ramp centerline.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  
Arc Between Elements 

Procedure: 

Hint Remember if you don’t like what is drawn, use the “Undo” tool <ctrl> - Z 
on your keyboard or Edit > Undo on the Power InRoads main menu bar!  

 

1. Open Start_ch3.dgn.  
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2. Select the 50 KPH standard from the Design Standards Toolbar. (This was docked in an 
earlier exercise.) Ensure the icon to the left of 50 KPH is toggled on (indicated by the 
orange color). 

 

3. Set the Feature Toggle Toolbar Linear > Geometry > Geom_Ramp and ensure the Override 
Feature Definition icon is still toggled on (orange). 

4. Select the Arc Between Elements tool. (You may have to select the small black triangle to 
expand the tool selection list to see it.) 

5. Now we’ll carefully follow the heads-up prompts attached to the cursor to draw our loop: 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the cross road centerline. 

Enter Back Offset Key-in 17.6. Move to the right of the centerline and data point to accept. 

Locate Second Element Select the mainline centerline. 

Enter Ahead  Offset Use the key-in to enter  22.3 and then data point to the north of the centerline to 
accept.  

Select Construction Sector 
/ Radius 

A ramp is displayed on the screen, however, we want a loop.  Click <Alt> on the 
keyboard to toggle between a loop and a ramp.   

If you are zoomed out quite a distance, you’ll see a huge loop, based on our 
standards. Since we cannot consume that big of a footprint, change the Design 
Standard to One Step Below Desired Minimum at 50 KPH. (Click the + to the left of 
50 KPH to display this option. Note the red loop is substantially smaller and the 
radius value in the dialog is now set to 127. Be sure your cursor is in the northeast 
quadrant so you are drawing the northeast loop and data point to complete the 
construction.  

 

 

Completed Northeast Loop 

 Exercise: Construct The Northwest Loop Alignment 

This loop has a smaller footprint than the northeast loop we just completed. Therefore, we will need 
to drop our standard one more step. Another option would be to lower the design speed. We will 
develop the inside edge as the alignment, then later we can offset for the outside edge of the loop.  
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Objective: Construct the inside ramp centerline.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Arc Between Elements  

Procedure: 

Hint Remember if you don’t like what is drawn, use the “Undo” tool <ctrl> Z 
on your keyboard or Edit > Undo on the Power InRoads main menu bar!  

1. Continue in start_ch3.dgn. 

2. Select the 50 KPH\Two Steps below Desirable Minimum at 50 KPH design standard from 
the Design Standards Toolbar and ensure the icon to the left of 50 KPH is toggled on 
(indicated by the orange color). 

 

3. Verify the Feature Toggle Toolbar is still set to Linear > Geometry > Geom_Ramp and 
ensure the Override Feature Definition icon is still toggled on (orange). 

 

4. Select the Arc Between Elements tool. 

5. Now we’ll carefully follow the heads-up prompts attached to the cursor to draw our loop: 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the cross road centerline. 

Enter Start Offset Snap to the existing edge of pavement to the left side of the centerline, then data 
point to accept.  

  

However, we could have entered 15m rather than selecting graphically.  

Locate Second Element Select the mainline centerline. 

Second Offset In this case, it’s the same as the previous loop, -22.3m. Move the cursor to the north 
of the mainline alignment and data point to accept. 

Select Construction Sector 
/ Radius 

Move the cursor into the northwest quadrant to see the northwest loop. Note our 
radius is different than the northeast ramp, since we changed our Design Standards.  
It should be a smaller footprint than our northeast loop. Data point to accept.  
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Completed Northeast and Northwest Loops 

EDITS AND MANIPULATION OF ELEMENTS 

As we saw in the last session, an advantage of placing civil elements is the ability to dynamically edit 
them. This is also true of complex elements, such as the loops we just developed.  

 Optional Exercise: Edit the Northeast Loop 

Objective:  

 We will review the edit manipulators and handlers for the loop. 

Geometry Tools Used:  

 None. 

Procedure: 

1. Zoom into the northeast loop so it fills the screen. 

2. Select the loop (using the element selector).  

 

3. We can edit the offsets, radii, or transition lengths. Experiment by changing the values and 
see the dynamic updating. 



Developing the Southwest Loop 

 

40  Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical 

Geometry 

  Copyright © 2013 Bentley Systems, Inc. 

DEVELOPING THE SOUTHWEST LOOP 

For this alignment, we will once again use the Design Standards. However, we will combine it with 
the Spiral Curve Spiral tool. In this case, the tool does not have the option for offsets, so we need to 
select the actual elements.  

 Optional Exercise: Develop the Southwest Loop 

Objective:  

 Construct the inside ramp centerline.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Spiral Arc Spiral 

Procedure: 

1. Continue in start_ch3.dgn. 

2. Select the 50 KPH\Two Steps below Desirable Minimum at 50 KPH design standard from 
the Design Standards Toolbar. Ensure the icon to the left is toggled on (indicated by the 
orange color). 

 

3. Verify the Feature Toggle Toolbar is still set to Linear > Geometry > Geom_Ramp and 
ensure the Override Feature Definition icon is still toggled on (orange). 

  

4. Select the Spiral Arc Spiral tool. 

  



Developing the Southeast Loop 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 41 

Copyright © 2013 Bentley Systems, Inc. 

5. Now we’ll carefully follow the heads-up prompts attached to the cursor to draw our loop 
using the illustrations as a selection guide: 

 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the east-west element that we created earlier. 

 

Locate Second Element Select the outside existing edge of pavement of the cross road.  

 

Select Construction Sector / 
Radius 

First, note your MicroStation prompt includes <ALT> Loop, so click the <ALT> key on 
your keyboard.  This toggles from loop to ramp.  Move the cursor to see the 
southwest loop. The Radius is displayed. However, we don’t have to use Radius as 
our input. In the heads-up prompt, type d55 <enter>. The Radius field in the dialog 
changes to the degree input and the loop changes dynamically. Data point to accept. 

Trim / Extend Option Set to Back and data point to accept the construction.  

 

Completed Southwest Loop 

DEVELOPING THE SOUTHEAST LOOP 

For this alignment, we will once again use the Design Standards. However, we’ll combine it with the 3 
Center Curve tool. In this case, the tool does not have the option for offsets, so we need to select the 
actual elements.  
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 Optional Exercise: Develop the Southeast Loop 

Objective: 

 Construct the inside ramp centerline.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  
3 Center Arc 

 

1. Use the 50 KPH\One Step below Desirable Minimum at 50 KPH design standard from the 
Design Standards Toolbar. Ensure the icon to the left of 50 KPH is toggled on (indicated by 
the orange color). 

 

2. Verify the Feature Toggle Toolbar is still set to Linear > Geometry > Geom_Ramp and 
ensure the Override Feature Definition icon is still toggled on (orange). 

  

3. Select the 3 Center Arc tool. 

4. Now we’ll carefully follow the heads-up prompts attached to the cursor to draw our loop 
using the illustrations as selection guides. 
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HEADS-UP PROMPT USER ACTION 

Locate First Element Select the east-west element.  

 

Locate Second Element Select the edge of the cross road.  

 

Select Construction Sector / Radius Enter <ALT> from your keyboard to toggle to a loop.  Move the cursor to 
see the southeast loop. Use the arrow keys (<>) to move to see the options 
for Back and Ahead Transitions. 

Select Construction Sector / Back 
and Ahead Transition Lengths 

Set the Back and Ahead Transition Lengths to 100. Don’t forget to enter 
after your value to lock it in. When all fields are set, data point to accept.  

Trim / Extend Option Set to Back and data point to accept the construction.  

 

 

Completed Southeast Loop 
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CHAPTER SUMMARY 

In this chapter, we have utilized the Complex Arcs tool in conjunction with Design Standards to 
develop new loop alignments. We used a new Feature Definitions to distinguish the loop alignments 
from the mainline. We also reviewed the element manipulator and edit fields. 

 

Four completed loops 
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Chapter 4: Developing Ramps 

OVERVIEW 

Now that we have completed the loops, we can begin work on the ramps. There are a variety of ways 
to develop the ramps, and numerous different ways (and tools) to accomplish it. Keep in mind that 
we are demonstrating the tool usage, as we can’t design the entire interchange in one short 
workshop.  

CONSTRUCT THE NORTHEAST RAMP 

 Exercise: Construct the Northeast Ramp 

Objective: 

Construct the inside ramp centerline of the northeast ramp.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  
Arc Between Elements 

  
Complex By Elements 

  
Single Offset Partial Element  

Procedure: 

1. Open the file Start_ch4.dgn.  

2. Use the 50 KPH\One Step below Desirable Minimum at 50 KPH design standard from the 
Design Standards Toolbar. Ensure the icon to the left is toggled on (indicated by the orange 
color). 

 

3. Set the Feature Toggle Toolbar to No Feature Definition and turn off the Feature Toggle 
Override. We’ll build the elements and when we connect them, we’ll assign a feature 
definition at that time.  

4. Select the Arc Between Elements tool. 

5. At the top of the dialog, toggle off Loop. Note the Radius and Transition fields are 
populated with our Design Standard. 
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6. Now let’s enter some of our taper information into the dialog.  

FIELD VALUE 

Back Taper section  

     Method Ratio-Offset 

     Offset 5 

     Ratio  1:15 

Back Transition section  

     Geometry Spiral 

     Method Length 

     Length 70.25 (set by standard) 

Ahead Taper  

     Method None 

Ahead Transition  

     Type None 

7. Now we’ll carefully follow the heads-up prompts attached to the cursor. 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the mainline element.  

Enter Back Offset 17.9m. Data point to the north of the alignment to accept.  

Locate Second Element Select the loop alignment. 

Enter Ahead Offset 17.6m. Data point to the outside of the alignment to accept.  

Select Construction Sector 
/ Radius 

Move the cursor to see the ramp. The Radius is displayed from our standard. Data 
point to accept. 

  

Trim Options Set to None and data point to accept. 

Now we’ll repeat the process to get the section of the alignment between the cross road alignment 
and the ramp.  

8. Select the Arc Between Elements tool again. 

9. We need to change a few entries in the dialog. Be sure the Ahead Taper and Ahead 
Transition sections are set to None. 

FIELD VALUE 

Back Taper section  

     Method Ratio-Offset 

     Offset 5 

     Ratio  1:50 
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10. Now we’ll carefully follow the heads-up prompts attached to the cursor. 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the existing edge of pavement on the cross road.  

Enter Back Offset 0.  Data point to the right of the road to accept.  

Locate Second Element Select the loop alignment. 

Enter Ahead Offset -17.6m. Data point to the outside of the alignment to accept.  

Select Construction 
Sector / Radius 

Move the cursor to see the ramp. The Radius is displayed from our standard. Data 
point to accept. 

Trim Options Set to None and data point to accept. 

 

 

Two segments of the northeast ramp 

11. Select the Single Offset Partial Element tool.  

12. Now we’ll carefully follow the heads-up prompts attached to the cursor, based on the 
illustration below. 
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HEADS-UP PROMPT USER ACTION 

Locate Element Select the northeast loop centerline.  

Start Parameters Offset Snap to the end of the working element we just drew that is connected to the cross 
highway. Note if the offset is locked you can hit the <End> key to unlock. 

End Distance Snap to the end of the working element we created connecting to the mainline 
alignment.  

Mirror No. 

13. Select the Complex By Elements tool to create the alignment (from the cross road 
alignment to the mainline alignment).  

14. In the dialog, set the Method to Automatic. Set the Maximum Gap to 0.03. We also want 
to set our Feature Definition to HA Ramp and set the Name Prefix to NE_Ramp. 

  

15. Follow the heads-up prompts, using the green working elements we just created. 

HEADS-UP PROMPT USER ACTION 

Locate Element Select the northeast ramp as shown in the image. Watch that the arrow is pointing in the correct 
direction. Data point to accept. 

 

Accept Complex Once the entire ramp has changed color, data point to accept.  
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Completed Northeast quadrant – loop and ramp 

CREATE THE NORTHWEST RAMP 

In order to fit the ramp in between the loop and a nearby frontage road, we are going to develop the 
alignment using the curve points of intersection (P.I.) along with our Design Standards. Then we can 
dynamically modify to fit our design.  

 Optional Exercise:    Create the Northwest Ramp 

In this exercise, we’ll use 5 points to create our alignment. Since we are not using Design Standards, 
we’ll need to populate the curve and transition data.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  

Complex by PI 

 

Procedure: 

1. Continue in start_ch4.dgn and select the Saved View “NW Ramp.” 

2. Set the Feature Toggle Toolbar Linear > Geometry > Geom_Ramp and ensure the Override 
Feature Definition icon is toggled on (orange). 

  

3. Turn off the Design Standard by disabling the icon.  

4. Select the Complex by PI tool. 
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5. Follow the heads-up prompts, using the illustration as guidance. Blue triangles have been 
placed in the file representing the desired locations of the 5 PI locations. 

 

Five points used as P.I. for northwest ramp. 

 

HEADS-UP PROMPT USER ACTION 

Enter First P.I.  Place the point on the edge of the existing cross highway. Note we could also have built a 
taper first and used that as our starting point, as the P.I. tool does not have offset options.  

Enter Next P.I. / Radius Place the point, still on the edge of the existing cross highway. Enter a Radius of 90 
<enter>, then right arrow and set the Back Transition Length to 0, right arrow and set the 
Ahead Tangent Length to 0. Data point to accept. 

Enter Next P.I. / Radius Place the third data point to the north of the loop ramp.  Note the Radius and Lengths 
values remain set, so we just have to data point our way through the points.  

Enter Next P.I. / Radius Place the fourth and fifth data points as shown in the image. Once the 5th point is placed, 
reset to complete. 

6. If you don’t like the placement, select the element, and dynamically adjust or change the 
edit fields.  

7. Using the methods you’ve learned previously, station the alignment and report on it. 

 

CREATE THE SOUTHWEST RAMP 

We are going to use a variety of tools for this area. First, we need to realign the southern access so it 
is perpendicular to the mainline. Then we’ll modify the roadway from two way to one way to provide 
an entrance to the cross highway. This will set us up to realign the access road on the north side of 
mainline.  

 Optional Exercise: Create the Southwest Ramp 

Objective: 

 First, we’re going to realign the road to the west of the southwest loop. We’ll use this for both 
the southwest loop, and as a new intersection for the access road to the north. We want to be 
sure it’s perpendicular to the mainline alignment. We’ll use the Line to Element tool, but we 
could also use the Line by Points in conjunction with a Perpendicular snap. 
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Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  
Line To Element 

  
Reverse Curve by Tangent 

Procedure: 

1. Continue in the file start_ch4.dgn and select the Saved View “Southwest Ramp.” 

2. We won’t use any feature definitions for the first steps, so set the Features Toggle Bar to 
No Feature Definition.  

3. Select the Line To Element tool. 

4. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

End Point  We’ll place a point on the north side of mainline. Note there is a pink triangle to give you an 
approximate location. 

Locate Element Select the mainline alignment. 

Offset Use 175m so it intersects the existing alignment and we have some line length to work with 
later. Data point to accept. 

Skew Use 90. (No need to type the minutes and seconds.) Data point to accept. 

Start Distance 0 

Select Solution DP to accept. 

Trim/Extend DP to accept. 

5. Set the Design Standard to 50 kph/Two Steps below Desirable Minimum and toggle on the 
standard. 

6. Select the Reverse Curve by Tangent tool.  

7. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the working line we just created. 

Enter Start Point Snap to the bottom of the working line.  

 

Locate Second Element Select the outside left edge of pavement on the cross road alignment. 

Linear Transition Length Set to 175m and enter.   

Start Point Move the cursor near the original start point until the reverse curves fit, without overlapping 
the southwest loop. Moving the cursor to the right – left changes the shape of the curves. 
Data point when you’re satisfied with the layout.  

Trim / Extend Back 
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8. We could use the Complex By Elements tool to connect the working element with the 
reverse curves. However, we want to use that same element on the north side, so we’ll 
wait to finish up connecting the ramp alignment at that time.  

CREATE THE SOUTHEAST RAMP 

We are going to use the Taper Arc Taper tool for this ramp. However, the tool does not support 
offsets, so we have offset the southeast loop for the minimum distance between the two roadways 
and the mainline to account for the exit ramp. The Offset Partial Element tool was used to create 
these working elements.  

 Optional Exercise: Create the Southeast Ramp 

Objective:  

 Create the two segments of the southeast ramp that will be combined with an offset loop 
segment to create the entire ramp alignment. 

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

 
 

Taper Arc Taper 

 

Procedure: 

1. Continue in the file start_ch4.dgn and select the Saved View “SE Ramp-1”.  

2. We won’t use any feature definitions, so set the Features Toggle Bar to No Feature 
Definition.  

3. Set the Design Speed to 50 kph and enable it.  

4. Select the Taper Arc Taper tool. 

5. In the dialog, set the following: 

FIELD VALUE 

Back Taper Method None 

Ahead Taper Method Ratio-offset 

 Offset 5 (width of the ramp) 

Ratio 1:15 (to fit within our project limits) 
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6. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

Locate First Element  Select the working element offset from the southeast loop. 

 

Locate Second Element Select the working element offset from the mainline alignment. 

 

Select Construction Sector / Radius  The Radius should be set to 255m from our Design Standard. Do NOT data point 
yet! View the curve and ensure the taper is within project limits, then data point to 
accept.  

Trim / Extend Both.  

 

Completed segment of southeast ramp 

Now we’ll use the same tool and process to add the segment from the cross highway to the loop.  

7. As we have limited project limits on the cross road alignment, set the Design Speed to 50 
kph\ Two Steps below Desirable Minimum at 50 kph.  

8. Select the Saved View “SE Ramp-2.” 

9. Select the Taper Arc Taper tool. 

10. Verify the dialog is still set: 

FIELD VALUE 

Back Taper Method None 

Ahead Taper Method Ratio-offset 

 Offset 5 (width of the ramp) 

Ratio 1:15 (to fit within our project limits) 
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11. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the working element offset from the southeast loop.  

 

Locate Second Element Select the outside existing edge of pavement of the cross road alignment. 

 

Select Construction Sector / Radius  The Radius should be set to 90m from our Design Standard. Data point to 
accept the construction..  

Trim / Extend Back.  

 

 

Completed segments of southeast ramp 

12. Using the methods you’ve learned previously, create an alignment, station and report on it. 
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CHAPTER SUMMARY 

In this chapter, we have learned more tools in horizontal geometry, specifically working with 
complex-type alignments. 

 

Completed Project Illustrating Loops and Ramps 
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Chapter 5: Final Clean-up 

OVERVIEW 

Now that we have the mainline, loops and ramp alignments complete, there’s still a lot of work to be 
done. We can add more edges of pavement and shoulders with the Offset tools. We can add tapers 
and gore areas to complete the plan drawings. Many of these are done using the same tools we have 
already been working with in previous chapters. 

Before we tackle those tasks, we have a few access roads to redesign, and a few more tools to try 
using!  

REALIGN THE NORTHEASTERN SIDE ROAD 

We’ll start by using a separate turnout lane (3.6m). This has already been drawn using the Single 
Offset Partial tool. Next we’ll establish the centerline for the existing roadway. Then we’ll add the 
fillets and tapers. 

 Exercise: Readjust Northeastern Side Road 

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  
Line From Element 

  
Line To Element 

  
Simple Arc 

   
Variable Offset Taper 

Procedure: 

1. Open the file start_ch5.dgn.  

2. Use the Saved View “Northeastern Side Road.”  

3. We won’t use any feature definitions for these first few steps, so set the Features Toggle 
Bar to No Feature Definition.  



Realign the Northeastern Side Road 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 59 

Copyright © 2013 Bentley Systems, Inc. 

4. Select the Line From Element tool. We’re going to use it twice to establish two points on 
the existing centerline.  

HEADS-UP PROMPT USER ACTION 

Locate Select the left edge of pavement of the road.  

Enter Offset 0 and data point to accept. 

Enter Start Point Snap to the north end of the edge of pavement. 

Enter Skew Key in 90 <enter>, then right arrow on your keyboard to Start Distance, which you set to 
0. Data point to accept and move to the next prompt.  

Enter End Distance Snap to the other side of the roadway. 

Trim Set to Back and data point to accept.  

5. Select the element you just drew, which displays the edit manipulators. One edit field is the 
length of the line. Change the edit field from 8 to 4.0 (be sure to <enter> on the keyboard 
after typing in the value). The line is now half as long so its endpoint is the center of the 
existing roadway.  

      

6. Repeat the process again so we have two centerline points of reference. 

 

 

7. Select the Line To Element tool.  

8. Set the Feature Definition to Geom_Secondary. 
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9. Follow the heads-up prompts.  

HEADS-UP PROMPT USER ACTION 

Enter End Point  Snap to the green working element (labeled point 1) at the north end of the roadway.  

Locate Element Select the mainline alignment.  

Offset 0 

Skew Snap to the other working element (labeled point 2) we created. If the skew is locked, then 
press the <End> key on the keyboard to unlock it. 

Start Distance 0, then data point to accept. 

Select Solution Select Solution 1. 

Trim/Extend None. 

 

10. Select the Simple Arc tool.  

11. Set the Feature Definition to Road_EdgeofPavement. 

12. Follow the heads-up prompts.  

 

HEADS-UP PROMPT USER ACTION 

Locate First Element  Select the existing edge of pavement. 

Locate Second Element Select the working element which is the edge of the new turnout lane. 

Enter Through Point / Radius 25 

Trim Set to Both, as it will not trim the existing pavement (as it’s in a reference file). 

13. Repeat for other radius, but this time set the Trim to None. 

 

 Completed side road 

14. To add the taper to the turnout, select the Variable Offset Taper tool.  

15. Set the Feature to Road_EdgeOfPavement. 
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16. Follow the heads-up prompts.  

HEADS-UP PROMPT USER ACTION 

Locate Element  Select the mainline alignment. 

 

Start Offset Snap to the end of the side road radius. 

 

End Offset Snap to the edge of the mainline at the end of the project. 

 

Mirror No. Data point to accept. 

 

17. Final clean-up, striping, etc. can be done at the user’s discretion. 

    

Completed taper for turnout 
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REROUTE THE NORTHWEST ACCESS / FRONTAGE ROAD 

The expanded interchange, and in particular the northwest ramp, have cut off access from the 
northwest community. A safety issue is the number of accesses onto the main highway, so it is 
desirable to minimize the number, and make them normal to the mainline highway. Therefore, the 
original northwest access will be closed, and the road re-routed to the new intersection slightly to the 
west of the old location. Finally, it’s combined into an intersection with the southwest ramp.  

 

 Exercise: Rework the Northwest Access / Frontage Road 

Objective:    

 Create the segments of the northwest frontage road that uses the same intersection as the 
southwest ramp. 

 

Geometry Tools Used:  

 

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  
Reverse Transition 

 

Procedure: 

1. Continue in the file start_ch5.dgn. Select the Saved View “Northwestern Access.”  

2. Toggle off the Design Speed Standard.  

3. Select the Reverse Transition tool.  

4. Set the Feature to Geom_Ramp. 
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5. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

Locate First Element  Select the existing frontage road at the northern end. 

 

Enter Start Offset 0; Data point to accept. 

Locate Second Element Select the southwest ramp alignment. 

 

Offset 0; Data point to accept. 

Define Length Right arrow through the prompts.  Set the Back and Ahead Radius to 90.  Set the Length 
around 75. Data point to accept. 

Then move the cursor until you have a reasonable set of reverse curves and do not 
encroach upon the mainline pavement.  

Enter Start Point This slides the curves along the existing frontage road. Data point to accept. 

  

Trim / Extend Ahead 
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Completed Northwest Access / Frontage Road 

6. Using the methods you learned previously, store the southwest ramp alignment, station 
and report on it. 

SET UP WIDENING AT BEGINNING OF PROJECT 

The beginning of the project, the existing highway is two lane, and we are widening into a four lane 
roadway. Reverse curves are an excellent method for widening tasks, so we’ll use the Reverse Curve 
by Radii Ratio twice, once on the north side of mainline, once on the south side. Then we can 
complete the intersection by adding the corner radii.  

 Exercise:  Widening Roadway 

Objective:  

 Add and edge of pavement edge to each side of the mainline roadway to account for widening 
from two lanes to four lanes.  

Geometry Tools Used:  

HORIZONTAL GEOMETRY GROUP ICON TOOL 

  
Reverse Curve by Radii Ratio 

Procedure: 

1. Continue in the file start_ch5.dgn. Select the Saved View “Widening.”  

2. Toggle off the Design Speed Standard, as we are not designing alignments.  

3. Select the Reverse Curve by Radii Ratio tool.  

4. Set the Feature Definition to Road_EdgeOfPavement. 

5. In the dialog, set the Radius Ratio to 2:1 and lock by toggling on the box to the left of each 
field.  

  



Chapter Summary 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 65 

Copyright © 2013 Bentley Systems, Inc. 

6. Follow the heads-up prompts, using the illustration below for guidance. We’ll start with the 
north side of mainline first. 

 

Prompts shown for both north and south side widening 

 

HEADS-UP PROMPT USER ACTION 

Locate First Element  Select the existing edge of mainline pavement. 

Enter Start Point Snap to mainline near the end of the access road radii (indicated by the X in the illustration). 

Locate Second Element Select the proposed edge of pavement in the area indicated. 

Radius Move the cursor until you have a reasonable set of reverse curves, then data point to accept.  

Enter Start Point In this command it is required to select the Start Point twice.  Snap to mainline near the end 
of the access road radii (indicated by the X in the illustration). 

Trim / Extend Back 

7. Repeat the process for the southern widening. 

 

CHAPTER SUMMARY 

In this chapter, we have worked with some miscellaneous tools that are helpful in completing tasks 
to wrap up our project. 

  



Overview 

 

66  Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical 

Geometry 

  Copyright © 2013 Bentley Systems, Inc. 

Chapter 6: Introduction to Vertical 
Geometry Tools 

OVERVIEW 

Civil Geometry is a dynamic, interactive, rules-based approach to geometry that provides an 
unprecedented level of associativity by preserving design intent, snaps and Civil AccuDraw input. The 
results of the tools are intelligent graphic elements which can be dynamically edited and associations 
between elements which are automatically updated. 

The results of the tools are graphical geometry elements stored as MicroStation elements. There is 
no external geometry file. The geometry elements are MicroStation elements with additional 
intelligence applied to store the rules and associations.  

The Civil Geometry tools are installed as a part of GEOPAK, InRoads and MXROAD products. In order 
to be consumed by processes within GEOPAK, InRoads and MXROAD, the civil geometry must be 
written to the native application coordinate geometry file (ALG, GPK or FIL). This is handled 
automatically. Elements are written to and updated in the native application based on properties of 
feature definitions. 

PROJECT DESCRIPTION 

In this workshop, we will construct vertical geometry (profiles) for our mainline alignment, a cross-
road alignment, and parts of the interchange including ramps, loops and access roads. Note the view 
is rotated so the mainline is displayed in a west-east orientation.  

 

Alignments created with horizontal geometry tools 
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The table below details the dimensions we’ll use throughout the project. 

DESCRIPTION VALUE 

Units Metric 

Stationing Format 1+234 

Design Standards U.K.  (modified) 

Vertical Curve Parameter K Value 

NAVIGATING TASKS 

Within the Tasks dialog, the General Geometry and Vertical Geometry tasks are located in the Civil 
Tools Workflow.  (Note your tabs may vary slightly, depending on what Bentley products are 
installed.) 

 

Click Activate Workflow to view the main tasks.  To open the toolset, click Expand Group. Click the 
same icon to Collapse the Group. 
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There are several ways the Groups can be displayed.  For this workshop, we’ll use the Panel Layout 
Mode, which is the default.  

 

If you prefer listings rather than icons, you may prefer the List Layout Mode. 

 

Your preference may be to not use the Task dialog. Other options include: 

 Select any tool from Tools > Civil Geometry from the Power product main menu bar. 
 Select <F2> from your keyboard, which opens the main workflows pop-up menu.  

This may vary depending on what products are installed and any task customization.   
Select Civil Geometry. Select <F2> from your keyboard and General Geometry from 
the pop-up menu.  Then you can use Q, W, E, R, T, or A (corresponding to the letters 
to the left of the group). For example, selection of W opens the Geometry 
Import/Export pop-up menu. 
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To use the classic toolbox for any sub-group, right-click   on the line and select Open ‘…’ as Toolbox.  

 

You can also customize which tools are displayed. Other customizing options can be found by right-
clicking on the navigation groups. Customization of task navigation is outside the scope of this 
workshop, but you may want to experiment in your spare time or after the workshop is concluded.  

Hint If the Task dialog disappears or you accidentally close it, select Tools > Tasks from the 
Power product main menu bar to bring it back. 

In this section, we will review some of the tools and settings that will be used throughout the 
workshop. For easy accessibility, we will dock the tools within the MicroStation view.  

PROFILE SETTINGS 

When working with vertical geometry, there are several settings that you need to be aware of and 
set based on your project requirements.  These include: 

 Stationing 
 Vertical Curve Parameter 

 

 Exercise: Open Design File and Tools 

Lesson Objective: 
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We’ll set up for Design Standards, Features, and Messages for subsequent exercises.  We’ll also verify 
our profile settings. 
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Tools Used: 

GENERAL GEOMETRY GROUP ICON TOOL 

  

Design Standards Toolbar 

  

Civil Message Center 

MicroStation > File > Project Explorer 

 

Project Explorer 

MicroStation > Settings > Design File  Profile Settings 

Procedure: 

8. Double-click the Power InRoads or GEOPAK icon on your desktop. 

9. In the lower right corner of the File Open dialog, set the User to Examples, Project to 
Bentley-Civil-Metric, and Interface to Bentley – Civil. 

10. Navigate to the class folder as directed by the instructor, select Start_ch1_2.dgn and click 
Open. 

11. Select the Design Standards Toolbar tool from the General Geometry group. 

  

12. Dock and pin the Design Standards Toolbar at the top. 

13. Verify that the Civil Message Center tool is docked at the bottom of the view.  

This is for feedback on our design standards and geometry tools.  

 

14. Verify that the Project Explorer.  is docked on the left side of the view.  

This is for reviewing design standards and feature definitions. 

 

Hint The Project Explorer can also be found in the Primary Tools toolbar, but is 
hidden by default.  Right-click on the toolbar and select Project Explorer to 
enable access from the toolbar. 
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15. Select Settings > Design File from the MicroStation or Power product main menu bar. 

16. Select Civil Formatting in the Category list (left side).  

 

17. Scroll down to Station Settings and be sure the Format is set to s+sss and Precision to 0.12.   

18. Scroll down to Profile Settings and verify/set the following: 

FIELD SETTING 

Elevation Precision 0.12 

Slope Format Percentage 

Slope Precision  0.12 

Vertical Curve Parameter KValue 

19. Close the Design File Settings dialog. 

20. Verify the MicroStation / Power Product View toggles are already docked at the bottom of 
the view.  If not, select Tools > View > View Groups and dock.  Only view 1 should be on at 
this time. 

 

21.  On your keyboard, select<Ctrl> <F> to Save Settings. 
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FEATURES AND FEATURE DEFINITIONS 

A Feature is anything that can be seen or located and is a physical part of your design, representing a 
real world entity.  Examples include curb and gutter, pavement, power lines, trees, etc.  Often it is a 
physical thing but might be an intangible but measurable entity such as a centerline.   

When we create features (geometry elements), we use the Features Toggle Bar to define what the 
geometry represents, its Feature Definition..  

 

Feature definitions are used to define the nature of the created features. Feature Definitions are 
usually created in advance, usually used across multiple projects, and define symbology, annotation 
and quantities. The feature definition is assigned to the base geometry, often in the plan model, but 
surfaces are 3D elements and thus the feature definition is defined in the 3D model. 

At any given time in the design process, the feature will be defined by horizontal geometry, vertical 
geometry, 3D geometry or a combination to define its location. Generally, the feature’s definition is 
assigned at time of creation, but can be assigned after-the-fact. 

Most horizontal geometry tools have entry fields for Feature Definition in their dialog. One example 
is illustrated (left) below. An example of a vertical geometry tool is also shown (right) below.  

        

The vertical tool does not have a Feature Definition field.  That’s because it’s utilizing the Feature 
Definition of its horizontal element (except in the case of a profile from terrain where it uses the 
terrain feature definition).  In other words, the profile is merely a different presentation of the 
horizontal feature and thus inherits the feature definition. Three presentations are supported:  
Profile, Intersected Profile and Projected Profile. 
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It has a Name Prefix, so it doesn’t use the same Name Prefix as the horizontal geometry.  For 
example, we can have one horizontal element named CL, but we want the existing ground profile 
name prefix to be EX.  Another example is the naming of special ditch grades with DITCH.   

Infrequently, we may want to override symbology of the profiles.   For our horizontal element, we 
may have special ditch grades or other generic offset profiles, and we want them to be easily 
distinguishable by different symbology and to control which are displayed at a given time.  We can 
use Element Templates for this purpose, which are stored in a DGNlib.  One example of Element 
Templates is illustrated below.  It is important to understand that the element template merely 
overrides the symbology of the element, the feature definition remains unchanged. 

   

Examples of Element Templates for Vertical Geometry 

We also have more feature definitions in profiles than in plan view.  As noted in the Properties of the 
HA Roadway, (viewed from the Project Explorer), different styles can be defined for Intersected 
profiles and Project Profiles.  Either Native Styles or Element Templates can be used.  

Note Regardless of the use of the Element Template or Feature Definition, you can 
always assign a Name Prefix to be used.   

CHAPTER SUMMARY 

In this introductory chapter, we learned about settings for using vertical geometry, and how features 
and feature definitions are utilized. 
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Chapter 7: Using Existing Data 

OVERVIEW 

To begin any project, you may need some type of existing data. It may be CAD files from prior 
projects, survey information, terrain models or even historical paper plans. You can mix and match 
the type of data you have for your project.  If you have no data, you can even start with a blank file 
and develop your horizontal geometry.  Then you can begin to work on vertical geometry. 

Note You must have a horizontal geometry element in order to develop vertical 
geometry. 

In our project, we will use some historical data as a starting point for one to develop our mainline 
vertical geometry.  We’ll use the import functions for that exercise.  Then we’ll take a look at whether 
the existing vertical geometry meets design standards.   

Another critical tool is the development of existing ground profiles from terrain models. We’ll look at 
two tools used for that purpose.    

IMPORTING DATA 

In some projects, you may have data from a previously constructed project.  In these cases, we need 
to use the data in one of the native Bentley products (i.e., MX, InRoads, or GEOPAK).   

Note You must be in the same native product where the data was created in order to 
import.   

We cannot bring in vertical geometry without its accompanying horizontal geometry.  During the 
import process, we’ll need to select both the horizontal geometry and which profiles are associated 
with it.  Even though the alignment and profile may have the same name, they are not automatically 
associated. 

 Exercise: Import Profiles 

Exercise Objective:   

Import the mainline alignment and associated profiles and view in 2D.   

Geometry Tools Used: 

GENERAL GEOMETRY PANEL ICON TOOL 

  

Import Geometry 
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Procedure: 

22. Continue in Start_ch1_2.dgn. 

23. Select the Import Geometry tool. 

24. Power Inroads: Select vertical_workshop.alg (in your project folder) and click Open.  

Power GEOPAK:  Select job89.gpk (in your project folder) and click Open. 

Note your dialog may vary slightly from the one illustrated below. 

 

25. Navigate the tree and toggle on Alignment.  

26. We’ll bring in all the alignments, but we want to be selective on profiles.  Under CL-
MAIN, toggle on Profile and toggle OFF EX_MAIN, which is the existing ground 
profile.  Note only CL-MAIN has profiles.  

27. Ensure that Create Civil Rules is toggled on. 

28. Click Import.  (If you are using GEOPAK you may be prompted for the GPK file again.  
Use job89.gpk.) 

Note Note our view is rotated so it will display in a west-to-east direction.  
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Imported alignments overlaid on existing roadway topography  

 Exercise: View Imported Profiles 

Exercise Objective: 

 Verify the profiles were imported by viewing in the Profile Model. 

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Open Profile Model 

 

Procedure: 

29. Continue in Start_ch1_2.dgn. 

30. Select the Open Profile Model tool and follow the heads-up prompts.  

HEADS-UP PROMPT USER ACTION 

Locate Plan Element Select the CL-MAIN alignment in view 1. 

   

Select or Open View From the MicroStation or Power product View groups, select view 8.  (This toolbox should 
be docked at the bottom of view 1). 
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Design Profile and Three Ditch Profiles for CL-MAIN 

 

PROFILE MODEL VIEWS 

While working with horizontal and vertical geometry, it is important to keep in mind the 
following fundamentals: 

 A horizontal alignment has one and only one profile space. 

 A profile space corresponds to one and only one horizontal alignment. 

 A profile space can (and usually does) define multiple profiles. 

 Only one of the multiple profiles can be active for design at any given time. 

 If the profile for parallel or intersecting horizontal alignments needs to be seen in 
relationship to the profile then use the project profile commands. 

 

CL_MAIN Design and Existing Ground Profiles 

The Profile Model View has some unique characteristics: 

 Associated horizontal geometry name is in the title bar of the view. 
 Elevation labels on left edge of the view 
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 Station labels along bottom of the view. 
 This is a true profile space whose coordinates are station, elevation instead of X,Y. 
 The background colors indicate curvature of the horizontal alignment.   
 Normal background = straight 
 Cyan background = curve 
 Magenta background = spiral 
 Civil AccuDraw is profile aware and adjusts its function accordingly. 
 When using the vertical commands the cursor gives simultaneous feedback of 

location both in plan and profile. 
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The Profile Model View also has easy access to the vertical geometry tools, right from the view 
window.  

 

Quick Access Profile Menu LIsting 

 
The tools can also be docked as a toolbox. 
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 Exercise: Working with the Profile Model View 

Exercise Objective: 

Review the aspects of the Profile Model view, how to customize, and how to change symbology of 
various profiles.  

Procedure: 

31. Continue in Start_ch1_2.dgn. 

32. Open the view attributes box for the profile model and experiment with the vertical 
exaggeration settings.  The view is exaggerated while preserving the true coordinates. 

 

33. Continuing in the Profile Model View, select the longest profile and review the pop-up info 
to ensure you selected CL-MAIN. 

34. Select the Element Templates under Vertical Geometry to override the feature symbology.  
Note the profile options are located under the LINEAR hierarchy. 

 

Select the two right ditch profiles and assign the element template 
 Profile_Special_Ditch_R. 
Select the single left ditch profile and assign the element templates 

 Profile_Special_Ditch_L. 
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Hint Hover over the ditch profiles and the pop-up display shows the feature 
name, i.e., right or left ditch profile.  

  

All Imported Profiles for CL_MAIN 

 

35. Select Display Levels from the MicroStation or Power product menu.  Ensure that it’s set to 
View 8 (or the view of your profiles) and turn off the levels Profiles – Ditch Left and Profiles 
– Ditch Right.  Use Default as your active level. Turn on the weight attribute and close the 
View Attributes dialog.  You now have just the Design Profile displayed on your screen.  

 

CL-MAIN Design Profile 

VERTICAL GEOMETRY REPORTS 

As we are working on developing vertical geometry, we’ll want to get some hard-copy reports.  Many 
reports are available in the Civil Report Browser, with the default report being the Vertical Alignment 
Review Report.  The report is accessible from the Vertical Geometry navigation task menu or the 
context pop-up menu. 
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 Exercise: Generating and Reviewing the Vertical Geometry Report 

Exercise Objective: 

Create the Vertical Alignment Review Report for our imported CL-MAIN vertical geometry. 

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Profile Report 

 

Procedure: 

36. Continue in Start_ch1_2.dgn.   

37. Select the Profile Report tool and follow the heads-up prompt. 

HEADS-UP PROMPT USER ACTION 

Select First Profile Element Select the CL-MAIN vertical geometry in View 8. 

Locate Next Profile Element – Reset to Complete Reset. 

Hint For quicker access to the tool, use the pop-up context sensitive menu! 

38. Scroll down in the Civil Report Browser to review the report. 

 

39. If time permits, click on some of the other available vertical geometry reports. 

USING EXISTING TERRAIN DATA 

Generating an existing ground profile for your alignments is a common task in any project.  There are 
three different ways to accomplish this workflow: 

 Quick Profile From Surface 
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 Profile From Surface 
 Set Terrain Model 

The Quick Profile From Surface and Profile From Surface tools calculate elevations of an element by 
matching the elevations of a surface encountered along the element's path. The surface may be a 
terrain model, a mesh, or mesh solid. 

Let’s start with the Quick Profile from Surface for our CL-MAIN alignment. 

QUICK PROFILE FROM SURFACE 

As its name implies, the Quick Profile From Surface tool is an efficient way to generate a profile from 
a surface.  The only required inputs are indentifying the reference element and the surface.  

 Exercise: Generate An Existing Ground (Quick) Profile for CL-MAIN 

Exercise Objective: 

Generate and review the ground profile from our project terrain model of existing ground (which is in 
a reference file).  The symbology of the profile is from the feature definition of the terrain model.  

Geometry Tools Used: 
 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Quick Profile From Surface 

Procedure: 

40. Continue in Start_ch1_2.dgn. 

41. Select the Quick Profile From Surface tool from the Profile Model View pulldown menu. 

42. In the tool settings, enter the Name Prefix as EX-CL-MAIN. Note the Element Template is 
left set to None as the symbology from the terrain model feature definition is used. 

 

43. Follow the heads-up prompt. 

HEADS-UP PROMPT USER ACTION 

Locate Reference Element In the PLAN view (1), select the CL-MAIN alignment.  Note if you had either CL-MAIN 
alignment or profile selected, this reference element is already highlighted and you won’t 
see this prompt. 

Locate Reference Surface In the PLAN view (1), select the boundary of the terrain model (orange dot/dash element). 

Locate Next Profile Element 
– Reset to Complete 

Reset. 
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Existing Ground Profile is Overlaid on the Design Profile 

44. Close view 8. We can re-open it later as needed. 

 

PROFILE FROM SURFACE 

Another tool to generate a ground profile from a terrain model is the Profile From Surface tool.  It is 
similar to the Quick Profile From Surface tool, but has more settings and options to give more 
flexibility to the tool.   For example, you can create a profile for part of an element or set of elements 
by specifying the start and end distance. You also have options for horizontal and vertical offsets.  
These options are not available in the Quick Profile From Surface tool.   

   

 

 Optional Exercise: Creating a Profile From a Surface 

Objective: 

For this exercise, we will use the alignment SWRAMP. 
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SWRAMP alignment imported from our ALG or GPK File 

 

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Profile From Surface 

Procedure: 

45. Continue in start_1_2.dgn. 

46. Create a Profile Model view for the SWRAMP, using window 4.  

Hint Use the Open Profile Model tool we learned in the View Imported Profiles exercise.  

The view will be empty because we have not created any profiles for this alignment as yet. 

47. Select the Profile From Surface tool. 

48. In the Profile from Surface dialog, input the following: 

Name Prefix: Ex_SWRamp 

Element Template: None 
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49. Follow the heads-up prompts.   

HEADS-UP 

PROMPT 
USER ACTION 

Locate First 
Element to Profile 

In the PLAN view, select the first horizontal element (i.e., beginning of alignment if that is what you 
are profiling) that intersects the surface (terrain model).   

Locate Next 
Element to Profile 
– Reset To 
Complete 

Keep selecting elements, until all are identified, When you've selected all of the elements you wish to 
profile, right-click in an empty area to complete the selection and move to the next prompt. 

Locate Reference 
Surface 

In the PLAN view (1), select the boundary of the terrain model surface. 

Start Distance In the PLAN view (1), move to the beginning of the alignment and data point to accept.. 

End Distance In the PLAN view (1), move to the end of the alignment and data point to accept.. 

Point Selection Use the down arrow key (on your keyboard) to navigate the options then <Enter> to execute your 
choice.  We’ll use All.  

All – the entire element is used for elevation determination 

Vertices – elevations are computed only at the vertices of the element 

Ends – elevations are computed only at the end points of the element 

Centroid – elevation is computed only at the centroid 

Point Adjustment Use the down arrow key (on your keyboard) to navigate the options then <Enter> to execute your 
choice.  We’ll use None. 

None – no adjustment is performed 

Minimum – of the points used in previous step, select the minimum elevation and use this value for 
the entire profile 

Maximum – of the points used in previous step, select the maximum elevation and use this value for 
the entire profile 

Draping Option Use the down arrow key (on your keyboard) to navigate the options then <Enter> to execute your 
choice.  We’ll use Triangles.  

Triangles – determine an elevation at every point where the element crosses a triangle leg 

Break lines – determine an elevation only when element crosses a break line 

Horizontal Offset Key in 0 then <Enter> to lock it in and data point to accept. 

Vertical Offset Key in 0 and < Enter> to lock it in and data point  to accept. 

 

50. Fit the Profile View to see the existing profile for SWRAMP. 

51. Close the Profile Model View. 

SETTING AN ACTIVE TERRAIN MODEL 

The most common use for setting an Active Terrain Model is for existing ground.  Among other 
purposes, defining an active Terrain Model serves to automatically draw existing ground in the profile 
space and is the target for side slopes which do not otherwise specify a target surface. 

 Generating a Profile From an Active Terrain Model 

Objective: 

 We’ll create an existing ground profile using the existing terrain model and we’ll use a quick 
way to open a Profile Model view.  In this exercise, we’ll use EASTRD. 
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EASTRD Alignment Imported From the ALG File 

Geometry Tools Used: 

GENERAL GEOMETRY PANEL ICON TOOL 

  

Set Active Terrain Model 

 

Procedure: 

52. Continue in start_1_2.dgn.  

53. Select the Set Default Terrain Model tool.   

Note Note this is in the General Geometry panel, not in Vertical Geometry.  It can 
also be found in the Terrain Model tools.  It can also be selected from the 
context sensitive pop-up menu. 

54. Follow the heads-up prompt “Locate Terrain Model to Use as Default” and select our 
terrain model boundary (orange) in the plan view. 

A message is displayed in the message center that the Active Terrain Model has been set.  

55. Use the Element Selection tool to select the EASTRD horizontal geometry in View 1. 

56. From the context pop-up menu, select the Open Profile Model tool (second from left). 

 

Context Pop-up Menu Displays When Element is Selected 

57. Open view 5 from the View Groups toolbox.  

58. Data point in View 5 to display the profile.  Note you may need to fit the view to see it.  The 
existing ground profile is shown automatically by virtue of setting the active Terrain Model 
before defining the profile window. 
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East Rd. Existing Ground Profile 

  



Chapter Summary 

 

90  Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical 

Geometry 

  Copyright © 2013 Bentley Systems, Inc. 

CHAPTER SUMMARY 

In this chapter, we have learned about the Profile Model View, and how to import profiles and 
several ways to generate a profile from a terrain model or mesh. 

 

Summary of Profiles 

 

  



Chapter Summary 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 91 

Copyright © 2013 Bentley Systems, Inc. 

This page left intentionally blank.



 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 92 

Copyright © 2012 Bentley Systems, Inc. 

 

Chapter 8: Creating and Manipulating 
a Design Profile 

OVERVIEW 

Bentley Civil supports a wide variety of vertical geometry tools, so you can find a tool or set of tools 
for every requirement on your project.  In this chapter, we’ll start with some fundamentals by 
building on what we created in earlier chapters. 

We’ll use the Best Fit tool to create a design profile from our EASTRD.  The Best Fit tool is often used 
on preservation projects to build a design profile from existing centerline pavement profiles.  

Then we’ll take a look at design standards.  We’ll use our CL-MAIN and check to see if the work done 
in the planning stages (that we imported) meets our design speed standards.  Then we can use the 
manipulators to improve the quality of the profile so that it meets or exceeds standards. 

BEST FIT 

The Define Profiles by Best Fit tool constructs a profile complex defined by best fitting through a 
selected profile.  For example, pick an existing ground profile and best fit a profile to match the 
ground. 

Two options which widely impact the results are supported: 

 Simple Element - computes a single linear profile element with no option for an 
offset envelope.  Aside from Element Template and Name Prefix and selection of 
the profile, there are no other user input requirements. 

 Complex Element - option provides for offset values to define an envelope above 
and below the selected profile. It will build a complex profile with curves. 

 

Comparison of Profiles:  Initial profile (orange), Simple Element (Aqua), Complex Element (Green) 
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 Generating a Best Fit Profile 

Objective: 

 We’ll create a best fit profile from the existing ground profile for EASTRD that we created in an 
earlier exercise.  

 

EASTRD Alignment Imported From the ALGor GPK File 

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Define Profiles By BestFit 

Procedure: 

59. Start in start_ch3.dgn. 

60. Select the Define Profiles By BestFit  tool. 

61. In the dialog, key-in the following: 

Name Prefix: BF-EASTRD 

Element Template: None 

62. Follow the heads-up prompts.   

HEADS-UP PROMPT USER ACTION 

Best Fit :  Make Complex 
Element or Simple 

Select Make Complex Element and data point to accept and move to the next prompt. 

Locate Profile To Fit Select the existing ground profile for EASTRD (in View 4). 

Upper Envelope Use 0.25. 

Lower Envelope Use 0.0. 

Desirable Crest Curve Length Key-in 25 and <Enter>. 

Desirable Sag Curve Length Key-in 25 and <Enter>. 

Minimum Curve Length Key-in 15 and <Enter>. 
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East Road Existing Ground Profile (black) and Best Fit (red) 

4. Using the Element Selection tool, select the profile, right-click and select the Properties to see the 
values used for Best Fit. 

  

Properties Information for East Rd. 

Note The same information is also found in Element Information. 
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Element Information for East Rd. 

5. Close the Profile View. 

 

MANIPULATORS 

When any element created by a Civil Geometry tool is selected, certain manipulators are displayed 
dynamically. These manipulators vary by element type. 

Manipulators fall into four main types: 

 Text manipulators 
 Normal Drag Handles 
 Snap icons 
 Civil AccuDraw drag handles 

TEXT MANIPULATORS 

These can be clicked to make them editable, which lets you type in new values. Examples include  
distance and direction text manipulators in horizontal geometry, and length and slopes in vertical 
geometry. 

 

Examples of Horizontal (Left) and Vertical (Right) Text Manipulators 

NORMAL DRAG HANDLES 

These are handles that you can click and drag to redefine the element. 

 An arrow shaped drag handle – redefines the point with one or more directions 
constrained. For example, the parallel arrows (that are parallel to the line) are 
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constrained to change the distance only; the arrows that are perpendicular to the 
line are constrained to change the direction only. 

 

 A circular shaped drag handle – moves the points without constraint 

 

 Interval drag handle – This type of drag handle is present any time one of the 
MicroStation Modify commands are used on a civil element. This drag handle is 
used to change the location of the interval end point. 

SNAP ICONS 

If a point was created by a snap, the manipulator is shown as a circle with the appropriate snap icon 
next to it. 

 

Hovering over the circle will change it to a normal manipulator. Click and move the dot to remove the 
snap constraint and replace with new constraints. 

CIVIL ACCUDRAW DRAG HANDLES 

A point that was created with a Civil AccuDraw constraint will show a circle along with text 
manipulators depicting the Civil AccuDraw constraints which were input. 

Hovering over the circle will change it to a normal manipulator. Click and move the circle to break the 
Civil AccuDraw constraint and replace it with new constraints. 
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VERTICAL GEOMETRY MANIPULATORS 

Vertical geometry also has manipulators for: 

 Offset from base element (not shown here) 
 Delta Slope 
 Length 
 Drag a grip to dynamically adjust start and end distance 

 

 

DESIGN STANDARDS 

Design standards should be used throughout the design of your project.  It ensures that you are 
meeting minimal standards, generally based on design speed. They can also be based on type of 
roadway, and other geometric or design characteristics.   

Design standards are developed for both horizontal and vertical geometry (vertical new in Bentley 
Civil V8i SELECTseries 3) and are stored in DGNLibs.  Several default libraries are provided in the 
installation packages.  They are utilized by including the file / path in your MS_ DGNLIBLIST 
configuration variable.  An organization can modify the default libraries or create them from scratch, 
depending on your standards.   Multiple standards can be utilized, i.e., consulting firm doing work for 
multiple governmental agencies who all have their own standards.  

As you select a standard, it is copied from the DGNLib into your design file.  Therefore, your 
organization can maintain the integrity of the standards by having them “read-only” in a central 
location, but a designer has the flexibility to override for a project-specific circumstance.   The Project 
Explorer has one set of standards derived from DGNLibs, and another set shown for the design file.  
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In the Design Standards Toolbar, the Active Design vs. Design Library standards is clearly marked.  
Either can be selected for use. 

   

USING DESIGN STANDARDS 

Design standards can be used to maintain required curvature and other horizontal and vertical 
alignment checks when performing geometric layouts. They work at two levels: 

 Provide values for the element creation tools (for example, minimum radius and 
transition lengths in horizontal geometry, maximum slopes and K values for vertical 
geometry) 

 Check the suitability of complex elements (for example, check for kinks in both 
horizontal and vertical geometry) 

       

Examples of horizontal (left) and vertical (right) design standards 

DESIGN STANDARDS TOOLBAR 

The Design Standards Tool bar is accessible in either the General Geometry or Horizontal Geometry 
tool panels: 
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There is one icon for the Toolbar and a separate icon for the Set Design Standard tool, which is 
located on the Design Standards Toolbar. 

 

This toolbar allows you to set an active design standard subsequently used by most geometry tools. 
The leftmost icon is Set Design Standard, which can be used on previously created geometry 
elements. 

Procedure: 

63. Select the desired standard.  When a horizontal standard is selected, the “linked” vertical 
standard is displayed by default.  However, you can override by selecting a different 
vertical standard from the pick list.  

64. Toggle on the Toggle Active Design Standard (directly left of the horizontal design speed).  
When on (which appears orange), all civil geometry tools will use the values contained in 
the standard as defaults. When off, the selected standard is ignored. 

65. Create geometry elements.  

66. Selecting the element and opening Element Information displays the standard and 
associated values. 

       

Example of Horizontal and Vertical Design Standards Within Element Information 

Hint To remove a standard from a geometry element, right-click on the 
standard in Element Info and select Remove Standard. 
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DESIGN STANDARDS FEEDBACK 

When a design standard is violated, feedback is provided in two ways: 

 An icon in the graphics on the element that has the problem. Hover over the icon to 
reveal a tool tip report of the error. 

 In the Civil Message Center. 

 
Sample horizontal and vertical geometry messages in the Civil Message Center 

The tabs work like filters, so you can turn off / on MicroStation / Warnings / Errors as desired.  To 
quickly find the location of a problem, right click on the Warning or Error and select Zoom To.   

 

With the exception of the MicroStation messages, onscreen glyphs are displayed in the workspace to 
pinpoint the location.   

 

Error (left) and Warning (right) Glyphs 

Hovering over the glyphs displays a pop-up with the warning / error message. 

 

Example Pop-up Warning Message 

  



Design Standards 

 

102  Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical 

Geometry 

  Copyright © 2013 Bentley Systems, Inc. 

 Check and Manipulate Design Profile for Standards Compliance  

Objective: 

 In this exercise, we’ll use the CL-MAIN alignment / profile we imported in an earlier exercise and 
check to see if the preliminary alignments / profiles meet standards. 

       

CL-MAIN horizontal and vertical geometry used for design standards checking 

Geometry Tools Used: 

CONTEXT MENU (ON ELEMENT) ICON TOOL 

  

Open Profile Model  

General Geometry Panel Icon Tool 

  
Set Design Standard 

 

Procedure: 

67. Continue in start_ch3.dgn. 

68. Open View 8 from the View Groups toolbox.  

69. Note you may need to fit the view to see it.  Turn off the levels of any displayed profiles 
except the Design Profile.  While this is not required, it makes it easier to review / focus on 
the Design Profile. 

70. Select the 70 KPH design standard from the Design Standards Toolbar. (This was docked in 
an earlier exercise.) 

 

71. Toggle on the Toggle Active Design Standard, so it appears orange. 

72. Ensure you don’t have any elements selected, then from the Design Standards Toolbar, 
select the Set Design Standard tool.  When prompted, select the vertical geometry 
element.   

  



Design Standards 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 103 

Copyright © 2013 Bentley Systems, Inc. 

73. Expand the Civil Message Center which was docked earlier view the Warnings / Errors. 

 

74. Select the Error line, right-click and select Zoom To.   

 

75. According to the Error message, our K Value is 15, but needs to be more than 17 to meet 
standards.  Edit the K Value manipulator (on the bottom, curve length is on top) to 18 and 
note the glyph changes to a Warning, indicating it exceeds the minimum but does not meet 
the default.   

 

76. Change the K value to 31 and the glyph disappears and the Warning is removed from the 
Civil Message Center.   
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SETTING THE ACTIVE PROFILE 

Let’s assume for now that we have refined our vertical geometry for design compliance and we’re 
ready to move onto other work.  However, we will be using this design profile in subsequent 
exercises.  Whenever we want to use the CL-MAIN horizontal alignment, we want to use the design 
profile as well, rather than the existing or special ditch grades, etc.  Therefore, we will define the 
design profile as the Active Profile.  Another useful function of the tool is that it combines the 
horizontal and vertical geometry and draws a 3D element automatically for us. 

 Setting the Design Profile As the Active Profile  

Objective: 

We’ll select our design profile and set it as the active profile for CL-MAIN.  

       

CL-MAIN horizontal and vertical geometry used for design standards checking 

Geometry Tools Used: 

CONTEXT MENU (ON ELEMENT) ICON TOOL 

  

Set As Active Profile  

Note This tool can also be accessed from the Context pop-up menu. 

Procedure: 

77. Continue in start_ch3.dgn. 

78. In View 8, select the design profile, hover over it to access the Context Toolbar and then 
select Set As Active Profile. 
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79. Open View 7. 

80. Select View Attributes ( <CTRL>+B  ) and at the bottom in the View Setup section, select the 
MicroStation Model “Default-3D”. You’ll see our CL-MAIN horizontal and vertical geometry 
combined into a 3D element.  

You may need to fit the view to see the 3D geometry. 

 

3D view (top) of CL-MAIN and East Road Horizontal / Vertical Geometry Elements 

This is probably is not very impressive at this point, but let’s summarize what you are seeing: 

 The horizontal alignment has been combined with the vertical alignment to create a 
3D element. 

 This element has been placed in a 3D model created and maintained by the Civil 
technology.  

Hint Viewing of this model uses MicroStation’s dynamic views technology. 

CHAPTER SUMMARY 

In this chapter, we have learned to generate a Best Fit profile. We also worked with manipulators to 
remedy deficiencies in our preliminary design profile and reviewing for Design Standard compliance.   
Then we defined our design profile as the Active Profile to be used in subsequent exercises. 
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Summary of Profiles 
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Chapter 9: Component Profiles 

OVERVIEW 

One method of developing design profiles is by constructing various parabolas, curves, or lines, then 
connecting them together.  This method of building components uses two rows of tools in the 
Vertical Geometry toolbox:   

 Vertical Geometry Lines 
 Vertical Geometry Curves 

 

Once the components are built, they are connected together with the Profile Complex By Elements 
tool (the orange tool in the “R” row). 

Vertical Design Standards can be utilized with component profiles, or applied after construction.   

VERTICAL CURVE TYPES 

The options for curve type can be changed in the dialog or by pressing Shift key on keyboard. 
Supported curve types are: 

 Parabola – symmetric parabolic curve 
 Asymmetric – asymmetric parabolic curve 
 Circular – simple curve defined by radius 
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DEVELOPING THE WEST ROAD PROFILE 

 

West Access Road in the Project Layout 

This exercise will guide you through the process of designing the West access road profile where we 
will tie to CL-MAIN.  Our general workflow is: 

 Develop the mainline edge of pavement profile. 
 Draw the intersection points of mainline into the West Road Profile Model View. 
 Add profile (working) lines to each end of the existing ground profile to tie to 

ground. 
 Construct the reverse transition. 
 Add a vertical curve (parabola) to the lower tie down to ground. 
 Connect all the elements together. 

 Defining the Profile For the Mainline Edge of Pavement and Display in 3D  

Note the following set-up has already been completed, in order to expedite the actual exercise.  

 View 1 is located near the intersection of CL-MAIN and West Rd. 
 View 2 is open and defined as the Profile Model View for WESTRD. 
 View 7 has our 3D CL-MAIN element.  
 Our preliminary design for CL-MAIN shows a 14.3 meter median / roadway sloping at a constant 

slope = -2% (away from the centerline).  The edge of pavement was drawn (in 2D) using Civil 
horizontal geometry tools, but no slope / elevation has been applied. 

Objective: 

Before we start designing the West Road profile, we need to be able to view the cross slope of the 
mainline roadway.  To accomplish that, we’ll create a profile for the mainline edge of pavement and 
use it in conjunction with the centerline profile.  

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Profile By Slope From Element  

  

Profile Intersection Point  

Procedure: 

1. Continue in start_ch4.dgn. 
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2. Select the Profile By Slope From Element tool.    

3. Follow the heads-up prompts.  Even though we are defining a profile, all element selections 
are done in View 1. 

HEADS-UP PROMPT USER ACTION 

Select First Element to 
Profile 

Select the edge of pavement in view 1.  

Select Next Element To 
Profile – Reset to Complete 

 Reset 

Locate Reference Element Select the CL-MAIN alignment in view 1.  (The selected element must have an active 
profile.)    

.  

Slope Key in -2  <enter> and data point to accept. 

Point Selection All (which is the default)  Data point to accept. 

Profile Adjustment None.  Data point to accept. 

Vertical Offset 0.0   Data point to accept. 

 

 

CL-MAIN Alignment and Left Edge of Pavement Displayed in 3D 

We need to know how these two 3D elements (which form the cross-slope of the mainline) lie in 
relationship to West Rd.   

4. Select the Profile Intersection Point tool.   

5. Follow the heads-up prompts. Select the WESTRD road centerline as the element to profile. 

HEADS-UP PROMPT USER ACTION 

Locate Element to Show 
Intersection 

Select the WESTRD in view 1.  

Locate Element Which 
Intersects 

 Make sure you are selecting in View 7, which is 3D.  Select the edge of pavement.  

Locate Next Element Which Select the CL-MAIN alignment in view 7.  Reset to complete the intersections.  Note it 
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Intersects – Reset to 
Complete 

doesn’t matter which order you define the 3D elements. 

6. Look closely to see the two intersection points.  

 

Intersecting Profiles Displayed as Small Dots 

7. Close view 7, as we no longer need it. 

Now, let’s start the West Road profile design. 

 Develop the Design Profile For the West Road 

Objective: 

In this exercise, we will complete the following tasks: 

 Add profile (working) lines to each end of the existing ground profile to tie to 
ground. 

 Construct the reverse transition. 
 Add a vertical curve (parabola) to the lower tie down to ground. 

Vertical Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  
Profile Line Between Points  

  
Profile Reverse Transition  

  
Parabola Between Elements  

  
Profile Complex By Elements  

Procedure: 

81. Continue in start_ch4.dgn.  Expand view 2 (Profile – East Rd to fill the screen.) 

82. Working in Profile View 2, select the Profile Line Between Points tool.  Use the quick tools 
within the view.  
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83. We’ll start at the end where we have the two intersecting points.  Snap to the mainline 
centerline point for start point.   

84. Snap to the edge of the mainline pavement for second point. 

 

85. Repeat the Line Between Points procedure in the lower right corner (using the illustration 
as a guide), snapping to existing ground near 1+280 and the high point near 1+206. 

 

86. Set the Design Speed to 50KPH and toggle on Active Design Standard. 

87. Fit the view to see the entire profile.  

88. Select the Profile Reverse Transition tool.  

89. Follow the prompts.   

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the intersecting profile line in the upper left corner.  

Back Vertical Offset Enter 0 and data point.  

Locate Second Element Select the profile element in the lower right corner. 

Back Vertical Offset Enter 0 and data point.  
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Now the reverse transition dynamically moves along the second profile line (as indicated by 
the arrows in the illustration below.)   

 

Reverse Transition Construction Controlled By Cursor Movement Along Blue Dotted Line 

90. The curves are automatically forced to our Design Standards.  We want the tangent grade 
below 5%, so slide the dynamic to the right (around station 1+240), until the grade is less 
than 5%.  Data point to complete the dynamic. 

91. The reverse transition is now attached the cursor.  Slide upwards and snap to the edge of 
pavement in the upper left corner. 

 

92. Set the Trim / Extend option to Both and data point to accept.  The construction is 
complete.  The Element Selection shows the manipulators.   
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93. Select the Profile Line Between Points tool and place another line along existing ground 
from 1+280 (snap to other profile line we placed earlier) to 1+300 (end of the profile). 

94. Ensure your Design Standards are still active and select the Parabola Between Elements 
tool. 

95.   Follow the prompts.   

HEADS-UP PROMPT USER ACTION 

Locate First Profile Element Select the left profile line. 

Locate Second Element Select the right profile line.  

Vertical Curve Parameter  Move the cursor until the sag curve is displayed and data point.  

Trim / Extend Option Trim both and data point. 

 

 

Parabola Created Between Two Profile Lines 

 Combine the Elements To Complete the Design Profile For the West Road 

Objective: 

 Now we need to combine these individual components into one profile, called a complex.   

Vertical Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 
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Profile Complex By Elements  

Procedure: 

96. Continue in start_ch4.dgn and fit the view so the entire profile is displayed. 

97. Select the Profile Complex By Elements tool. 

98. We have mostly ignored dialogs today, but you may have to look at the dialog to change 
the Method from Manual to Automatic. 

99. Key-in “CL_WestRd” for the Name Prefix. 

   

100. Select the first element.  All connected elements will highlight. 

101. DP to Accept.  Now we have a vertical alignment for our West Rd. 

  

CHAPTER SUMMARY 

In this chapter, we have learned how to work with some of the foundation tools for profiles, i.e., 
building components and then combining them together into a profile.  While we don’t have time in 
this workshop, we can also manipulate the elements to rework them as needed for the project. 
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Chapter 10: Profiles by Vertical Points 
of Intersection (VPI)  

OVERVIEW 

The Profile Complex By VPI tool constructs a profile complex defined by vertical points of intersection 
(VPI).  Within the one tool, we can define the VPIs and then assign the associated vertical 
information.  Design standards can also be incorporated into the profile, or they can be set 
afterwards. 

 

USING THE PROFILE VPI TOOL 

First, open the Profile Model View 2 if not already opened and then select the tool.  

Note Checking the box next to any of the fields locks in the associated value. 

When you move the cursor into the Profile View, it is equipped with a tooltip that prompts you to 
"Enter First PI". Place the cursor over the initial point of intersection by left-clicking at the desired 
location. 

The tooltip prompts you to "Enter Next VPI", so use one of the following methods to designate a 
point through which the curve must pass (navigate the options by striking the left or right arrow 
keys): 
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 As you move the cursor, a value is displayed on the tooltip. Left-click at the desired 
value. 

 Enter a value for the Curve Length then strike the Enter key. 
 Enter a value for the Curve Parameter then strike the Enter key to lock in the value. 
 Enter a value for the Slope then strike the Enter key to lock in the value. The slope 

can always be locked independently of the length or curve parameter. 

Note The VPI can be positioned dynamically or with the aid of Civil AccuDraw. The 
heads up prompt can also be used to lock the desired slope value from the 
previous VPI to the current VPI. 

On the 3rd and subsequent VPIs, the Length and/or Curve Parameter can be used to control the 
curve placed at the previous VPI. For example, the length entered at the 3rd VPI prompt is used to 
define the curve at VPI 2. 

VERTICAL CURVE TYPE 

The option for curve type can be changed in the dialog or by pressing the Alt key on your keyboard. 
Supported curve types are: 

 Parabola – Symmetric Parabolic Curve 
 Asymmetric – Asymmetric Parabolic Curve 
 Circular – A simple curve defined by radius 

USING CIVIL ACCUDRAW WHEN DRAWING PROFILES 

In order to use precision key-in values in conjunction with the Complex by PI tool, Civil AccuDraw 
should be employed.  When activated, the heads-up prompt changes from its generic display and has 
the following benefits.   

a. With Civil AccuDraw active, we can key in exact values for stations and elevations. 

b. Parameter can be K-Value or R-Value which is defined in design file settings. 

c. The arrows on right of prompt indicate another input is possible here. 
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Click the right arrow or left arrow on your keyboard to change the prompt to curve length.   

 

Hint While hovering, the tooltip will give an indication of what the value is 
or what the handle will do. 

 

 

 Exercise: Vertical Alignment By VPI 

Objective: 

We’ll use the Profile Complex By VPI tool to construct six VPIs for our SWRAMP profile.  
We’ll tie to existing ground at the beginning (south end of the road), and connect to the 
edge of CL-MAIN on the end.  Stationing runs from south to north.   CL-MAIN pavement has 
already been drawn into the profile view.  Our completed profile is illustrated below for 
reference. 

 

Geometry Tools Used: 

GENERAL GEOMETRY PANEL ICON TOOL 

  

Activate Civil AccuDraw Toggle  

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Profile Complex By VPI  

 

Procedure: 
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Note These instructions are very detailed in the use of Civil AccuDraw.  For those 
who are already familiar with its use, the data for each VPI is summarized at 
the end of these instructions. 

102. Open start_ch5.dgn.  We’ll be using View 4 previously created for SWRAMP. 

103. Set the Design Standards to 50 KPH and enable the Active Design Standards toggle.  

104.   Activate the Civil AccuDraw toolbar and enable Civil AccuDraw. 
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105. Select the Profile Complex BY VPI tool.   

106. In the Complex Element dialog, enter the Name Prefix as Prop_SWRamp. 

   
107. First VPI: 

Our first VPI is going to tie to existing ground.  As the alignment runs along the existing 
roadway, we’ll move in slightly to sta. 0+020.   

a. Tab through the options in Civil AccuDraw until the cursor is in the Station field. Key 
in 20 and <ENTER>.  Note there is lock now on the stationing. Since our stationing is 
0+020, we only have to enter 20 and the rest fills in! 

 

b. Dynamically move the cursor up and down along the red line, which shows the 
station value is locked.  When the X indicating you’re on existing ground appears, 
data point to accept. 

Hint Use the “Nearest” snap to lock to the existing ground at station 
0+020.000 

c. That completes the first VPI. Note the first VPI is fixed in place and the profile is 
attached to the cursor. 

 

108. Second VPI: 
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We’ll want our first vertical curve to be outside the tie down point, but somewhat centered 
within the horizontal curve area (indicated by the coloring on the profile).   We also want to 
miss the peaks in the terrain model, some questionable field data that needs further 
investigation.   

a. Enter the station as we did in the first VPI using 0+100.  Key in the station as 100 and 
<ENTER>. This time we’ll use a slope so tab until you are in the Curve Length field 
where you see the <> arrows.  This tells us there’s more prompts available. Using 
the right arrow on the keyboard, arrow through the choices until you have it set to 
Slope.  Key in -2 and <ENTER>.   

 

 

Note The parameters for the vertical curve (such as length) are set by our 
vertical design standards.   

b. Place a data point in the workspace to complete the second VPI. 

 

109. Third VPI: 

For the third VPI, we want to decrease elevation, but we still want to be in a fill situation.  
Then we can use up some of the excess dirt we’ll have from the next 500m along the 
alignment.   

a. Enter the station as we did in the first VPI using 0+220.   

b. Tab to the elevation field, key in 334.00 and <ENTER>. 
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c. Place a final data point in a blank area of the workspace to complete the third VPI. 
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110. Fourth VPI: 

We’ll set our grade heading uphill slightly.  We also want to fit our vertical curve inside the 
horizontal curve area.  We also want to consider the algebraic difference of adjoining 
grades.  Since coming into the VPI is -4.3% and we don’t want to exceed 6% (which is our 
standard), we use 1.5%. 

a. Enter the station as we did in the first VPI using 0+340.   

b. Tab to the Vertical Curve Parameter field, right arrow to Slope and key in 1.5 
<ENTER>.  (Note this is a positive value). 

 

c. Place a final data point in a blank area of the workspace to complete the fourth VPI. 

 

111. Fifth VPI: 

We’ll continue to decrease our elevation in order to tie to the mainline pavement (shown 
pink at the far right side of the profile).  We also want to fit our vertical curve inside the 
horizontal curve area. 

a. Enter the station as we did in the first VPI using 0+540 and <ENTER>.  

b. Tab to the Elevation field and key in 331.28 and <ENTER>. 

c. Place a final data point in a blank area of the workspace to complete the fifth VPI. 

 



Using Civil AccuDraw When Drawing Profiles 

 

Day 2 - OpenRoads Technology Workshop: Horizontal and Vertical Geometry 123 

Copyright © 2013 Bentley Systems, Inc. 

112. Sixth (and final) VPI: 

For this VPI, we want to connect to the edge of the mainline roadway, already drawn in the 
file.  We’ll add a vertical curve in the swale area between our decreasing profile grade and 
the slope of the pavement. 

a. Hover over the edge of pavement until you see the X, then data point to accept. This 
completes the sixth VPI and our profile.   

 

b. Reset to exit the tool and complete the profile.  

c. Disable Civil AccuDraw. 

 

Completed SWRAMP Profile Using the Profile Complex by VPI Tool 

Note Note that the display of manipulators is dependent on your view.  If you are 
zoomed way out, you won’t see any manipulators.  As you zoom in, they are 
displayed based on the type of element and what is visible on the screen.  
Hover over the VPI to see its Station / Elevation. If you don’t see them, zoom in 
or out to change them. 

VPI SUMMARY 

VPI NUMBER STATION ELEV. GRADE 

1 0+020 340.78  (snap to ground)  

2 0+100  -2.0% 

3 0+220 334.0  

4 0+340  +1.5% 

5 0+540 331.28  

6 0+573.8 (snap to road)  331.97 (snap to road)  
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 Optional Exercise: Manipulate / Modify the Vertical Alignment By VPI 

Objective: 

We’ll review the type of manipulators that are used with the VPI tools.  Our design standards drew 
default vertical curves, so we can improve those by graphical manipulations.  

 

Procedure: 

113. Continue in start_ch5.dgn using the SWRAMP profile.  

114. Check the connection between the new centerline pavement and the tie to our SWRAMP 
profile.  Zoom in closely.  If you didn’t quite snap to the correct location, adjust by moving the 
end of the SWRAMP profile.  Use the Element Selection tool to highlight the profile and see the 
manipulators. 

115. Increase the length of curves to more closely match the horizontal curve lengths (which are 
color coded.)   

CHAPTER SUMMARY 

In this chapter, we have learned how to build a profile using VPI information.  We also learned how 
to utilize the power of Civil AccuDraw, with its command of station / offset / slope and other vertical 
geometry information. 
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Chapter 11: Miscellaneous Profiles 

OVERVIEW 

There are still a few tools that we have not utilized yet, so in this chapter we‘ll look at some examples 
of these tools and real-life project scenarios.  They include: 

 using data drawn with generic MicroStation tools 
 dummy profiles 
 ditch profiles 
 offset profiles for overlays or subsurface design 
 profiling curb returns 

USING DATA DRAWN WITH GENERIC MICROSTATION TOOLS 

Not all of our project data may be drawn with civil horizontal and vertical geometry tools.  We may 
want to utilize MicroStation elements or data from an external source, such as governmental 
agencies (counties, states, and cities) or consultants.   

We’ll use a tool to attach rules to the MicroStation elements, which changes them from generic 
elements to those that have edit manipulators and handlers.  Then they can be used in conjunction 
with other civil elements.  The tools are available for either horizontal or vertical elements.  

 Turning Generic MicroStation Elements into Horizontal Civil Elements 

Objective:  

 Change generic MicroStation elements comprising the Northeast and Northwest Loops into Civil 
elements.  

Geometry Tools Used: 

HORIZONTAL GEOMETRY PANEL ICON TOOL 

  

Create Civil Rule Feature 

 

Procedure: 

116. Open start_ch6.dgn.  

117. Select the Create Civil Rule Feature tool from the Horizontal Geometry panel.  

118. Select the N.E. Loop elements. 

119. Reset to complete the procedure. 
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120. Use Element Selection to view the edit manipulators, which tells us rules have been 
created.  You may have to zoom in to see the manipulators for the transitions. 

121. Repeat the process for the N.W. Loop. 

122. Set the Feature Definition to Geom_Ramp and Name Prefix to NE LOOP or NW 
LOOP and create complex horizontal elements for each loop. 

MAKING DUMMY PROFILES AT A CONSTANT ELEVATION 

There are occasions when you may need a profile, but don’t need or have specific data for it.  For 
example, in order to create a corridor, you need a profile.  If you’re working on a divided highway, 
the baseline may run down the median, but the actual profiles are down the edges of pavement.  In 
this case, you still need a profile for the baseline, even though it’s not used for anything. 

While you could use an existing terrain profile, we can also build a profile with a constant elevation 
very quickly as well. The Define Profile By Constant Elevation tool defines a flat profile at a given 
elevation for the entire element. 

 Create a Profile at a Constant Elevation 

Objective: 

 We’ll create a constant profile for N.E. Loop while we wait for additional terrain model data.   

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Profile By Constant Elevation  

Procedure: 

123. Continue in start_ch6.dgn.  

124. Select the Profile By Constant Elevation tool. 

Do not assign Name Prefix or Feature Definition at this time. 

125. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

Locate First Element Select the NWLOOP in view 1.  

Locate Element – Reset 
End 

Reset to end the selection phase.  

Enter Elevation Enter 330 and <ENTER>.  Data point to complete.   

Locate First Element We could do other alignments, as this tool loops back to the beginning.  Select Element 
Selection to exit from the tool. 

126. Open a Profile Model View and verify the elevation is a constant 330 meters, 
appearing horizontal in the view. 

127. Close the Profile Model View. 
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SPECIAL DITCH PROFILES 

There are numerous methods of developing special ditch profiles and a variety of tools are 
supported.  Some ditch profiles are developed with station / elevation information and do not 
require vertical curves.  There are several tools we could use to do this, but the simplest way is to use 
the Profile Line Between Points in conjunction with Civil AccuDraw to enter station / elevation or 
slope.   Another option is to utilize a horizontal element and develop the profile using any of the 
methods we’ve already learned.  To display the ditch profile overlaid on the roadway centerline, we 
can use the Project Profile tool.  

 

 Create a Special Ditch Grade Using VPI’s 

Objective: 

We’ll create a VPI-based profile using the Profile Line Between Points tool in conjunction with Civil 
AccuDraw. 

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  
Profile Line Between Points 

  

Profile Complex By Elements 

GENERAL GEOMETRY PANEL ICON TOOL 

  

Activate Civil AccuDraw Toolbar  

  

Features Toggle Bar 

Procedure: 

128. Continue in start_ch6.dgn.  

129. Open the Profile Model View for CL-MAIN in view 8.   

130. Activate the Civil AccuDraw toolbar and then enable Civil AccuDraw. 

 

131. Select the Profile Line Between Points tool.  

132. In the Features Toggle Bar, enable the toggle to Chain Commands. This will make 
this tool much more efficient in its use, as this will force the last VPI of the previous line 
placement to be used as the first VPI of the subsequent line placement. 
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133. Don’t worry about setting a Name Prefix or Element Template at this time. 

Follow the heads-up prompts to enter VPI’s at the following locations: 

 

STATION ELEVATION 

1+100 313.0 m 

1+150 312.5 m 

1+200 312.0 m 

1+250 311.5 m 

 

Once the fourth and final VPI is entered, Reset to exit the command. 

134. Disable Civil AccuDraw. 

135. Open the Profiles Complex by Element tool. 

136. Configure the dialog as shown. 

 

137. Identify the first element and accept the complex. 

138. Fit the view. 

139. Close the Profile Model View (8). 

 Display A Special Ditch Profile Onto the Roadway Profile 

Objective: 

We’ll project the already created ditch grade back onto the roadway profile.  

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  
Project Profile to Element  

  
Project Profile Range to Element  (Not used in this 
exercise, but can be used to project part of an element.)  

Procedure: 

140. Continue in start_ch6.dgn.  
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141. In View 1, select the MicroStation saved view “Northeastern Side Road.” 

     

CL-MAIN and Special Ditch (Green Arrow) 

142. Open the Profile Model in view 6 for DITCH_LT-2.  

143. Select the Project Profile to Element tool. 

144. Set the Name Prefix and Element Template.  

 

145. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

Select Element to Project Select the DITCH_LT-2 in the profile View 6 (blue dash line).  

Select Plan Element to Project Onto Select CL-MAIN in View 1.  

 

 
146. Close Profile Model View (6). 

147. Open the Profile Model View (8) for CL-MAIN. 

148. Note the project ditch profile near the end (Station 1+280 to end). Use the Element 
Selection tool to view its properties. 
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OFFSET PROFILES FOR SUBSURFACE DESIGN 

On some projects with varying types of geotechnical materials, it is necessary to vary the depth of 
aggregates and base materials under the roadway.  One way to accomplish this is with offset profiles.   
Using the design profile of the roadway, we can store a subsurface profile to be utilized within 
Corridor Modeler. 

Another example of offset profiles is for mill and overlay projects.  Offset profiles for milling depths 
or proposed top of pavement can be generated from the existing ground profile, and then optionally 
used in the Profile By Best Fit tool.  

 Create a Subsurface Profile 

Objective: 

We’ll create a subcut profile for the mainline alignment.  

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Profile Offset Transition 

  

Profile Complex By Elements 

  
Profile Line Between Points 

Procedure: 

149. Continue in start_ch6.dgn.  

150. Open the Profile Model View for CL-MAIN in View 8. 

151. Turn off all levels except the main design profile.   

152. Select the Profile Offset Transition tool. 

153. Set the Element Template to Vertical Geometry > Subsurface. 

154. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

Locate Element Note that if an Active Profile is set, you will not receive this prompt as it will by default use 
the active profile. If no active profile is set, then select the Design Profile in View 8.  

Start Parameters –Start 
Offset 

Enter -1.0 <ENTER> but do not data point yet!   Notice the black arrows to the right of the 
value, which indicate more prompts.   

Start Parameters – Start 
Distance 

Using the right arrow on your keyboard to view the Start Distance field.  Enter --0+100.  
Data point to accept.   

End Parameters – End 
Distance or Station 

Using the right arrow on your keyboard to view the End Distance or Station field.  While we 
could enter a value, let’s just use the cursor to define the distance.  Move the cursor to 
approximately 0+400.  Data point to accept.   

Mirror Use the arrows on your keyboard to set to No and data point to accept.  
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155. Repeat the tool to place a -3m offset between stations 0+460 and 0+ 700. 

 

Segments of CL-MAIN Subcut Profile 
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156. Select the Profile Line Between Points tool and connect the two offsets.    

 

CL-MAIN Design Profile (green) and Subsurface Profile (Dashed Blue) 

157. Select the Profile Complex By Elements tool and connect the three elements.  
Name as Subcut and use the Element Template to Vertical Geometry > Subsurface. 

158. Close the Profile Model view. 

PROFILING CURB RETURNS 

We have already created the edges of pavement for parts of CL-MAIN at the west end of the project 
near the SW Loop.  We have a filet drawn as a horizontal geometry element.  As the both edges of 
pavement have vertical geometry, we can create a quick profile for the curb return and review for 
drainage requirements.  The Define Quick Profile Transition between Elements tool defines the 
profile of an element by matching the slope and elevation of adjoining elements.  Two methods are 
supported: 

 The Parabolic method forms a smooth convex or reverse curve between the profiles 
of the adjacent elements. The instantaneous elevations and slopes are used to 
constrain the profile. 

 The Linear method simply connects a straight profile line between the profiles of 
the adjacent elements. The slope is not considered. 

Note The adjoining elements must have a design profile.  
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 Create a Profile Transition for the Curb Returns 

Objective: 

We’ll create a profile transitioning for the curb return in our S.W. Ramp and CL-MAIN intersection. 
The alignments and edges of pavement (except for the fillets) already have profiles attached.  So we’ll 
use those profiles to generate the transition. 

Geometry Tools Used: 

VERTICAL GEOMETRY PANEL ICON TOOL 

  

Quick Profile Transition  

 

Procedure: 

159. Continue in start_ch6.dgn.  

160. Select the MicroStation Saved View “Curb Return.”  

161. Open View 7 to view the 3D geometry. 

162. Select the Quick Profile Transition tool. 

Do not assign Name Prefix or Element Template at this time. 

163. Follow the heads-up prompts. 

HEADS-UP PROMPT USER ACTION 

Quick Transition Method Parabolic. Data point to accept. 

Locate What To Define Select the curb return fillet on the west side of the road. 

 

164. Repeat for the curb return on the east side of the road. 

165. Open a Profile Model View to view one of the curb return profiles. Leave the view 
open. 

166. Open a Profile Model View for the SW Ramp.  The elevation is a constant 330m. 

167. Select the edit manipulators and change the elevation to 333.  Note the change in 
the curb return profile as well as the 3D geometry. 

CHAPTER SUMMARY 

In this chapter, we have learned how to work with various project scenarios including ditch profiles, 
subsurface vertical geometry, utilizing non-Civil geometry elements, and quick profile transitions.   
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Assessment 

1. True or False: Civil horizontal geometry elements can be manipulated / edited. 

True.  Elements are easily manipulated by clicking on the element to display the element handlers.  
Then the element can be adjusted by clicking on the edit field and changing the value, or by selecting 
one of the graphic manipulators and dynamically moving. 

2. Which is NOT a Civil horizontal geometry tool? 

A. Start Station 

B. Place SmartLine 

C. Define Horizontal by Best Fit 

D. Create Complex by PI 

Answer: B. Place SmartLine is a MicroStation tool, not a Civil horizontal geometry tool.  

3. How can you use a Design Standard for horizontal geometry elements? 

A. Select the desired design standard first, then place the civil horizontal geometry element.   

B. All civil horizontal geometry elements automatically have design standards.  

C. Use the Set Design Standard tool to assign a standard to a previously drawn civil element.  

D. A. and C.  

Answer:   D – Design Standards can be assigned at the time of civil geometry creation or after the 
creation by using the Set Design Standard tool.  
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Appendix A: Setting Up the Workshop 
in Your Office 

OVERVIEW 

The workshop can easily be set up to run on your office computer or laptop.  The Civil Workspace 
used for this workshop is delivered with the installation package of the SELECTseries 3 products.  
Basic steps include: 

 Copy dataset from DVD to computer 
 Select the Civil Workspace when opening the first file, just as you did in the workshop.  

Note Note that many of the workshops use references files and other resources that are path 
dependent.  Therefore, you may want to utilize the same path as you did in the actual 
workshop.  
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Glossary 

2D Point Feature Contains no elevation (Z).  2D Point Features are defined and stored in plan model. 

3D Geometry 3D geometry is created in 3D model by mathematically combining the horizontal 
and vertical geometry to create 3D elements.  These 3D geometry elements in turn 
define a design model. 

3D Model This is created and managed automatically.  User can interact with it but this is not 
usually required.  The mathematical combination of Plan Geometry and Profile 
Geometry is stored in the 3D model. 

3D Point Feature 3D points can be defined in plan model or 3D model.  They are stored in 3D model 
but represented in both plan and 3D. 

Active Object The current object to which is added all geometry which is created. 

Active Profile Of the multiple possible profiles for an element, the active profile is the one used 
for design.  The active profile is combined with the horizontal geometry to build a 
3D element which is used in the 3D model. 

Active Terrain 
Model 

One terrain model can be designated as “Active”.  The active terrain model is the 
one used to display “existing ground”; in other words the one which displays 
automatically in a profile model when it is opened.  The active terrain model is also 
the one which is targeted by side slopes unless the template defines a different 
target by name. 

ALG A legacy (proprietary) InRoads file containing coordinate geometry information, 
superelevation, and alignment information for a specific geometry project. 

Alignment A linear feature which serves the special purpose of defining the centerline or 
baseline of a roadway. 

Apply Linear 
Template 

Applies a corridor template along a feature while hiding some of the complexity of 
creating a corridor. 

Apply Surface 
Template 

Applies a corridor template to a terrain model for the purpose of creating 
components (such as pavement layers) under the terrain model. 

Arc Definition Curve definition method generally used in roadway applications. The radius R is 
used to define the curve and is defined by the equation R=5729.58/D where the 
degree of curvature D is the central angle subtended by a 100-foot arc.   Set in the 
Design File Settings > Civil Formatting under Radius Settings.  See also Chord 
Definition.  
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Aspect An angular measure of the direction that the face of a surface is oriented. The 
format of the value is dependent on angular settings In the DGN file. 

Base Geometry In many instances the geometry element will be trimmed. The original (or base), 
untrimmed element is always preserved as it is the storage for the rule. 

Boundary  (Terrain 
Model)  

Used to constrain the external boundary of the terrain model. No triangles are 
created outside the boundary. In addition, any point data outside the boundary is 
ignored. 

Break Line A surface feature consisting of a collection of spatial coordinates that have an 
implied linear relationship. No triangle side (in the triangulated surface) can cross 
over a break line. 

Break Void A closed area of missing or obscured data that uses the elevations of each vertex, 
while the void lines between successive void coordinates are inserted as break 
lines. Therefore, break voids change the slope and elevations of the TIN surface. 

Cardinal Points One of the points used to define the geometry of an alignment. Cardinal points 
include PC, PT, PI, and CC points for horizontal geometry and VPC, VPI and VPT for 
vertical geometry.  

Centroid (triangle) Geometric center of a triangle in a terrain model.  

Chord Definition Curve definition method generally used in railway applications.  The radius R is 
used to define the curve, and is defined by the equation R=50/SIN(0.5*D) where 
the degree of curvature D is the central angle subtended by a 100-foot chord.  See 
also Arc Definition.  

Civil Cell Used as a mechanism to preconfigure commonly used complex geometric layouts.  
These layouts will commonly be stored in DGNLIB files for reuse across multiple 
projects but it is possible and sometimes useful to store directly in an active DGN 
file for use in that single location.  The civil cell will contain horizontal geometry 
and can also contain the vertical geometry. 

Civil Message 
Center 

Used to display a continuous updating log of Civil messages, including warnings 
and errors. As errors and warnings are resolved, they are removed from the list.  
New messages are added whenever the conditions warrant. Most messages relate 
to civil geometry, superelevation, and corridor modeling. 

Civil Template A civil design concept used most often for corridor modeling but also has other 
applications.  The Civil Template  defines the cross-sectional shape of the object 
being modeled.  This cross-section is then “extruded along” a 3D geometry 
element to form the final model. The corridor template can create or target 
features such as road edges.  The result is the creation of a corridor. 

Clipping Reference Clipping allows you to remove areas of overlap when working with multiple 
corridors in a single surface.  For example, in a corridor intersected by a crossing 
roadway, clipping would be used to remove all overlapped features within the 
intersection. 

Complex Terrain 
Model 

A terrain model created by merging or appending two or more terrain models.  
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Context Toolbox When an element is selected, hovering over the element provide a heads-up and 
context sensitive toolbar which pops up at the cursor.  This toolbar provides a few 
of the most commonly used tools which operate on the element selected element 
type. The first tool in this toolbar is always Quick Properties. 

Contour A linear symbol representing points of equal elevation relative to a given datum. 

Contour, Isopach Contours of a delta terrain model which represent cut and fill values as contours, 
not elevations. A positive contour represents fill, while a negative contour is cut.   

Contour, Major The primary elevation line indicating a specific elevation in a surface model. 
Usually major contours are drawn with a heavier line weight or using a different 
color. Elevation text labels are usually drawn in association with major contours. 

Contour, Minor A secondary elevation line indicating a specific elevation in a surface model. Minor 
contours are often drawn without special color or weight indexing and without 
elevation text labels. 

Corridor A civil object used for modeling a roadway and is automatically managed by the 
corridor modeling tools. 

Cross Section 
Model 

DGN models (extracted perpendicular to defined horizontal geometry) with special 
station elevation coordinates defined and other specialized capabilities such as 
view exaggeration. Cross section stations match the interval in the template drop 
when a corridor is used as the basis. When horizontal geometry is utilized, the left 
/ right offsets and interval are user-defined. 

Curve Stroking Stroking is the process of automatically adding shots to the terrain model or 
corridor by interpolating new shots from the curved sections of the data. This 
distance is used to interpolate new shots along the curved element in corridor 
processing and applying linear templates. This value is used as a perpendicular 
minimum distance from chords generated along the arc. Chords are drawn along 
the arc and the perpendicular distance is measured from the middle of each chord 
to the arc. If this distance is larger than the Curve Stroking, the process is repeated 
with a shorter chord length. This process is repeated until the end of the curve is 
reached. The flatter the curve, the fewer number of points will be calculated. The 
steeper the curve, the greater number of points that will be calculated. 

DDB File GEOPAK file (Design DataBase) which contains features definitions, associated 
symbology and annotation settings.  

Delta Terrain 
Model 

A surface containing data derived from the difference in elevation between two 
terrain models or a terrain model and a plane.  

Dialog The tool settings box for the active command.  The dialog shows all available 
options for a command.  For most civil commands, most of the time, the dialog can 
be hidden and ignored since the user is given all necessary instruction and inputs 
by way of the cursor prompt.  The dialog is necessary for configuring command 
customizations. 

Drape The process of vertically projecting elements onto a surface so that the element 
elevations are defined by the surface. 
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Drape Void A closed area of missing or obscured data where the void coordinates are not 
included in the triangulation. Voids are inserted post triangulation. The void 
coordinates and lines are draped on the TIN surface. Even though a user must 
provide an elevation for the Drape Void vertices, the user elevations are changed 
to the elevation of the TIN surface at the XY Drape Void coordinate position. 

Element Template MicroStation concept which allows preconfigured definitions for symbology and 
other miscellaneous display of MicroStation elements and civil features. 

End Condition A specialized component of a corridor template which provides information tie 
into active surface. 

End Condition 
Exception 

Used to modify the behavior of an end condition solution without requiring the 
use of additional template drops.  When an end condition exception is added, it 
must be edited to change its behavior. 

Export to Native Option to automatically or manually push horizontal and vertical geometry into 
native products (InRoads - ALG, MX - PSS and GEOPAK - GPK).   

Feature A Feature is anything that can be seen or located and is a physical part of your 
design, representing a real world thing.   A feature’s definition is one of its 
properties.  At any given time in the design process, the feature will have a 
Horizontal Geometry, a Vertical Geometry, 3D Geometry or a combination to 
define its location. 

Feature Definition Used to define options when creating features.  These are the items which are 
created in advance, usually used across multiple projects and define symbology, 
annotation and quantities.  The feature definition is assigned (usually) in the plan 
model and profile/3D feature definitions follow from there. 

Feature Name Each Feature can have a name. 

Gap When a feature is trimmed the part(s) which are invisible on the base geometry. 

GPK A legacy (proprietary) GEOPAK database containing coordinate geometry 
information. 

Graphical Filter Using in developing terrain models, an automated way of storing search settings 
for graphic elements when creating terrain models using 3D element. A graphical 
filter can be created for each feature (i.e., spots, breaks, voids) then the filters can 
be defined as a Graphical filter group.   

Heads Up  Prompt Command instructions are given in a heads up and dynamic prompt which floats at 
the cursor. 

Horizontal 
Geometry 

The elements which define the horizontal layout of the design.  These elements 
are 2D elements even if the DGN model is 3D. Horizontal Geometry may be points, 
lines, arcs, spirals, splines or any combination in a complex element. 

Interval When a feature is trimmed the part(s) which are visible on the base geometry. 

Island Closed area used to place within a void, i.e., islands in the middle of rivers, lakes, 
etc. 
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Key Station Additional station added to the corridor to force processing at the particular 
location.  

LIDAR (Light Detection And Ranging) is an optical scanning technology which scans 
ground and other physical features to produce a 3D model.  

Linear Feature In plan model, composed of lines,  arcs, spirals, splines or combinations of these.  
In profile model, composed of lines, parabola, splines or combinations of these. 

Linear Stroking Stroking is the process of automatically adding shots to the terrain model or 
corridor by interpolating new shots from the linear sections of the data.  Linear 
stroking is measured along the element.  Interpolated vertices are added 
whenever the distance between the vertices is greater than the linear stroking 
value (in master units). 

Manipulators The heads up, on-screen editing interface.  Only the most common properties are 
presented in manipulators.  Manipulators are in two types:  graphical and text 

Overlay Vertical 
Adjustment 

Within Corridor Model, tool used to develop a vertical geometry (based on milling 
and overlay parameters) and apply to the corridor. 

Parametric 
Constraints 

Used to set up constraint value overrides for specified station ranges.  

Plan Model The usual DGN model, used for laying out horizontal geometry.  Best practices will 
dictate that this is a 2D DGN model but 3D DGN model can be used.  This is where 
geometric layouts and corridor definitions are kept. The geometric layouts are not 
only alignments but also edges, parking, striping, sidewalks, etc. 

Point  Features Defined by a single X,Y  (Z optional) location. A point need not be a feature.  It may 
be defined as a non-featurized point by way of AccuDraw, Civil AccuDraw, Snap or 
a data point.  Non featurized points are use to control the construction of Linear 
Features. 

Point Cloud A set of vertices in a 3D coordinate system and these vertices are defined the by X, 
Y and Z coordinates. Point clouds are usually created by 3D scanners. These 
devices measure a large number of points on the surface of an object and output a 
point cloud as a data file. The point cloud represents the visible surface of the 
object that has been scanned or digitized. 

Point Control used to modify the behavior of points in a template. These controls take 
precedence (they override) over existing constraints on the point. 

Project Explorer MicroStation's interface for browsing elements in a DGN file.  Extended by civil to 
accommodate specialized civil needs. 

PSS File MX file (Plans Style Set) which provides the graphical representation for the MX 
string features.  

Reference Element The rule for some geometry is a calculation from another element.  This other 
element is the reference element. 
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Secondary 
Alignment 

Used to modify the direction of cross section processing.  By default, as any given 
station, the cross section is created orthogonal to the main alignment/feature.  If a 
secondary alignment exists, then that portion of the cross section which lies 
outside the secondary alignment will be orthogonal to the secondary alignment 
instead of the main alignment. 

SEP File / Method Uses the superelevation settings which originated in GEOPAK. 

SMD File GEOPAK file (Survey Manager Database) which contains survey features definitions 
and associated element and textual settings.  

Spot Elevation A set of X, Y, Z coordinates representing a point on the terrain model surface. 
There is no implied relationship between regular points. 

SRL File / Method Uses the superelevation settings which originated in MX 

Superelevation 
Lane 

The closed area defined by the superelevation tools used for the limits of 
transition calculations and pivoting location.  

Superelevation 
Section 

Area along a horizontal geometry element, where superelevation will be 
calculated.   

Target Aliasing Used to create the desired results when working with multiple surfaces without 
having to edit the template from the template library.  Target aliases can also be 
used so that one corridor can target the solution of another corridor. 

Template Drop An area (usually defined by station limits) along a corridor to which a specific 
template is applied.  

Template Library A file that stores definitions for templates, generally with an ITL file extension. 

Template 
Transition 

The transition indicator occurs in the corridor between templates of differing 
names. 

Terrain Model A three-dimensional DGN element defined by spots, break lines, voids, holes, 
contours to model a surface on the earth. 

Tooltips When hovering the cursor over an element or a handle, a tooltip is shown which 
gives explanatory information. 

Trace Slope Upstream - The indicated path follows the steepest ascent from a user-defined 
point through the terrain model terminating at a high point or the edge of the 
terrain model.  
Downstream - The indicated path follows the steepest descent from a user-defined 
point through the terrain model terminating at a low point or the edge of the 
terrain model. 

Vertical Alignment A linear feature in profile model which serves the special purpose of defining the 
elevations of an alignment. 

Vertical Geometry The elements which define the vertical layout of a corresponding horizontal 
geometry element.  These vertical elements are 2D and are stored in a profile 
model. 
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Void Closed shape to demarcate areas of missing data or obscure areas. No point or 
break data located within the void area is utilized and no triangles are created 
inside the void areas. The Void coordinates are included in the triangulation and 
void lines between successive void coordinates are inserted as drape lines on the 
surface. Therefore, they do not change the slope or elevations of the surface. 

Watershed Defined by either a low point within the terrain model or a low edge point along 
the terrain model edge, it's the closed area wherein all water would drain to the 
low point.  

XIN File InRoads file which contains features definitions, associated styles, annotation, and 
other settings.  
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